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QUESTION 1: 
 
 
Which VPN-1 NGX feature or command allows Security Administrators to revert to 
earlier versions of the same Security Policy? 
 
A. Policy Package management 
B. cpinfo 
C. cpconfig 
D. Database Revision Control 
E. upgrade_export/import 
 
Answer: D 

 
QUESTION 2: 
 
 
In SmartView Tracker, you see an entry for an outbound connection showing 
address translation. But when setting SmartView Tracker to show all entries for 
that connection, only outbound entries show. What is the possible cause for this? 
 
A. The entry is for a Manual Dynamic NAT connection, from a specific host infected by 
a worm. 
B. The entry is for a Manual Static NAT connection, where inbound traffic is managed 
by a separate rule. 
C. The entry is for a Static NAT connection, from a specific host that has been infected 
by a worm. 
D. The entry is for a Dynamic NAT connection from a specific host. 
 
Answer: B 

 
QUESTION 3: 
 
 
Which of the following commands is used to restore VPN-1 NGX configuration 
information? 
 
A. gunzip 
B. cpconfig 
C. fw ctl pstat 
D. cpinfo 
E. upgrade_import 
 
Answer: E 
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QUESTION 4: 
 
 
Which OPSEC server is used to prevent users from accessing certain Web sites? 
 
A. CVP 
B. DEFENDER 
C. URI 
D. FTP 
E. UFP 
 
Answer: E 

 
QUESTION 5: 
 
 
Your organization Certkiller .com's security infrastructure separates Security 
Gateways geographically. You must request a central license for one remote 
Security Gateway. How would you request and apply the license? 
 
A. Request a central license, using the remote Security Gateway's IP address. Apply he 
license locally with the fwputlic command. 
B. Request a central license, using the SmartCenter Server's IP address. Apply the license 
locally on the remote Gateway with the fwputlic command. 
C. Request a central license, using your SmartCenter Server's IP address. Attach the 
license to the remote Gateway via SmartUpdate. 
D. Request a central license, using the remote Gateway's IP address. Attach the license to 
the remote Gateway via SmartUpdate. 
E. Request local licenses for all Gateways separately. Apply the license locally on the 
remote Gateways with the fwputlic command. 
 
Answer: C 

 
QUESTION 6: 
 
 
How do you create more granular control over commands, such as CWD and FIND, 
in FTP data connections? 
 
A. Use Global Properties > Security Server settings. 
B. Use the gateway object's Security Server settings. 
C. Use the Service field of the Rule Base. 
D. Use an FTP resource object. 
E. Use FTP Security Server settings in SmartDefense. 
 
Answer: E 
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QUESTION 7: 
 
 
Which of the following is the final step in a VPN-1 NGX backup? 
 
A. Test restoration in a non-production environment, using the upgrade_import 
command. 
B. Move the *.tgz file to another location. 
C. Copy the conf directory to another location. 
D. Run the upgrade_export command. 
E. Run the cpstop command. 
 
Answer: B 

 
QUESTION 8: 
 
 
Choose the BEST sequence for configuring user management on SmartDashboard, 
for use with an LDAP server: 
 
A. Configure a server object for the LDAP Account Unit, enable LDAP in Global 
Properties, and create an LDAP server using an OPSEC application. 
B. Configure a server object for the LDAP Account Unit, enable LDAP in Global 
Properties, and create an LDAP resource object. 
C. Enable LDAP in Global Properties, configure a host-node object for the LDAP Server, 
and configure a server object for the LDAP Account Unit. 
D. Configure a server object for the LDAP Account Unit, and create an LDAP resource 
object. 
E. Configure a workstation object for the LDAP server, configure a server object for the 
LDAP Account Unit, and enable LDAP in Global Properties. 
 
Answer: C 
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340, Check Point Security Administration NGX I Student Handbook 

 
QUESTION 9: 
 
 
You want to create an IKE VPN between two VPN-1 NGX Security Gateways, to 
protect two networks. The network behind one Gateway is 10.15.0.0/16, and 
network 192.168.9.0/24 is behind the peer's Gateway. Which type of address 
translation should you use, to ensure the two networks access each other through 
the VPN tunnel? 
 
A. Hide NAT 
B. None 
C. Dynamic NAT 
D. Static NAT 
E. Manual NAT 
 
Answer: B 

 
QUESTION 10: 
 
 
Yoav is a Security Administrator preparing to implement a VPN solution for his 
multisite organization. To comply with industry regulations, Yoav's VPN solution 
must meet the following requirement: 
* Portability: Standard 
* Key management: Automatic, external PKI 
* Session keys: Changed at configured times during a connection's lifetime 
* Key length: No less that 128-bit 
* Data integrity: Secure against inversion and brute-force attacks 
What is the most appropriate setting Yoav should choose? 
 
A. IKE VPNs: AES encryption for IKE Phase 1, and DES encryption for Phase 2; SHA1 
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hash 
B. IKE VPNs: SHA1 encryption for IKE Phase 1, and MD5 encryption for Phase 2; AES 
hash 
C. IKE VPNs: CAST encryption for IKE Phase 1, and SHA1 encryption for Phase 2; 
DES hash 
D. IKE VPNs: DES encryption for IKE Phase 1, and 3DES encryption for Phase 2; MD5 
hash 
E. IKE VPNs: AES encryption for IKE Phase 1, and AES encryption for Phase 2; SHA1 
hash 
 
Answer: E 

 
QUESTION 11: 
 
 
How are cached usernames and passwords cleared from the memory of a VPN-1 
NGX Security Gateway? 
 
A. By pushing new user information from the LDAP server. 
B. By retrieving LDAP user information, using the fwfetchldap command. 
C. By using the Clear User Cache button in SmartDashboard. 
D. Usernames and passwords only clear from memory aftere they time out. 
E. By installing Security Policy 
 
Answer: E 

 
QUESTION 12: 
 
 
Which VPN-1 NGX configuration setting forces the Client Authentication 
authorization time-out refresh, each time a new user connection is authorized? 
Choose ONE. 
 
A. The "Refreshable Timeout" setting, in the Limit tab of the Client Authentication 
Action properties screen 
B. The Global Properties > Authentication parameters, adjusted to allow for "Regular 
Client Refreshment" 
C. The SmartDefense > Application Intelligence > Client Authentication > Refresh User 
Timeout option enabled 
D. The Time object, with hours restricted and renewable, in the Time field of the Client 
Authentication rule. 
E. The "Time" properties, adjusted on the user objects for each user, in he source of the 
Client Authentication rule 
 
Answer: A 
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QUESTION 13: 
 
 
Cody is notified by blacklist.org that his site has been reported as a spam relay, due 
to his SMTP Security Server being unprotected. Cody decides to implement an 
SMTP Security Server, to prevent the server from being a spam relay. Which of the 
following is the most efficient configuration method? 
 
A. Configure the SMTP Security Server to perform filtering, based on IP address and 
SMTP protocols. 
B. Configure the SMTP Security Server to apply generic "from" address to all outgoing 
mail. 
C. Configure the SMTP Security Server to allow only mail to or from names, within 
Cody's corporate domain. 
D. Configure the SMTP Security Server to perform MX resolving. 
E. Configure the SMTP Security Server to work with an OPSEC based product, for 
content checking. 
 
Answer: A 

 
QUESTION 14: 
 
 
Your internal network's internal IP address is 10.1.1.0/24. This network needs to 
connect to the Internet using the Security Gateway's external (public) IP address. 
How would you do this? 
 
A. Use Hide NAT on the network object in the 10.1.1.0 network. 
B. Use Static Source NAT on the network object. 
C. Use Dynamic NAT on network object 10.1.1.0/24. 
D. Use Static NAT on the network object in the 10.1.1.0 network. 
E. Use Static Destination NAT on the network object. 
 
Answer: A 

 
QUESTION 15: 
 
 
Jennifer wants to protect internal users from malicious Java code, but she does not 
want to strip Java scripts. Which is the BEST configuration option? 
 
A. Use the URI resource to strip script tags 
B. Use the URI resource to block Java code 
C. Use the URI resource to strip applet tags 
D. Use the URI resource to strip ActiveX tags 
E. Use CVP in the URI resource to block Java code 
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Answer: B 

 
QUESTION 16: 
 
 
You are the Security Administrator for Certkiller .com. Certkiller .com's Security 
Policy forces users to authenticate to the Security Gateway explicitly, before they 
can use any services. You are also reminded that your Gateway does not allow the 
Telnet service to itself from any location. How would you set up the authentication 
method? 
 
A. With a Client Authentication rule using the manual sign-on method, using HTTP on 
port 900 
B. With a Session Authentication rule 
C. With Client Authentication rule for partially automatic sign-on 
D. With a Client Authentication for fully automatic sign-on 
E. With a User Authentication rule 
 
Answer: A 

 
QUESTION 17: 
 
 
When you hide a rule in a Rule Base, how can you disable the rule? 
 
A. Run cpstop and cpstart on the SmartCenter Server, then disable the rule. 
B. Open the Rule Menu, and select "hide" and "view hidden rules". The select the rule, 
right-click and select Disable. 
C. When a rule is hidden, it is automatically disabled. You do not need to disable the rule 
again. 
D. Clear "Hide" on the drop-down list to make the rule visible, then select "Disable 
Rule(s)". 
E. Uninstall the Security Policy, and then disable the rule. 
 
Answer: D 
 
Explanation:  
Not B: B will only let you see the hidden rules but rules are still in hidden state. So it will 
not let you disable. 

 
QUESTION 18: 
 
 
Jeremy manages sites in Tokyo, Calcutta and Dallas, from his office in Chicago. He 
is trying to create a report for management, detailing the current software level of 
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each Security Gateway. He also wants to create a proposal outline, listing the most 
cost-effective way to upgrade his Gateways. Which two SmartConsole applications 
should Jeremy use, to create his report and outline? 
 
A. SmartView Tracker and SmartView Monitor 
B. SmartView Monitor and SmartUpdate 
C. SmartDashboard and SmartLSM 
D. SmartDashboard and SmartView Tracker 
E. SmartLSM and SmartUpdate 
 
Answer: B 
SmartLSM is a policy manager for enterprise VPN 
configs, not a resource monitor, and has nothing to do with viewing 
software versions/levels. Smartview Monitor does that. 
http://www.checkpoint.com/products/smartcenter/smartlsm.html 
http://www.checkpoint.com/products/downloads/svm_datasheet.pdf 

 
QUESTION 19: 
 
 
When restoring VPN-1 NGX using the upgrade_import command, which of the 
following items are NOT restored? 
 
A. Global properties 
B. Objects 
C. Route tables 
D. Security Policies 
E. License 
 
Answer: C 

 
QUESTION 20: 
 
 
Carol is the Security Administrator for a chain of grocery stores. Each grocery store 
is protected by a Security Gateway. Carol is generating a report for the 
information-technology audit department. The report must include the name of the 
Security Policy installed on each remote Security Gateway, and the date and time 
the Security Policy was installed. Which SmartConsole application should Carol use 
to gather this information? 
 
A. SmartView Status 
B. SmartView Monitor 
C. Smartpdate 
D. SmartView Tracker 
E. SmartLSM 
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Answer: B 
 
Explanation: Smartview Status was an NG product. It looks like it is now replaced 
by Smartview Monitor. 

 
QUESTION 21: 
 
 
When you check "Web Server" in a host-node object, what happens to the host? 
 
A. More granular controls are added to the host, in addition to Web Intelligence tab 
settings. 
B. SmartDefense Web Intelligence is enabled to check on the host. 
C. Automatic Static NAT is enabled on the host. 
D. The Web server is enabled on the host. 
E. You can specify allowed ports in the Web server's node-object properties. You then do 
not need to list all allowed ports in the Rule Base. 
 
Answer: A 

 
QUESTION 22: 
 
 
Your priCertkiller SmartCenter Server is on SecurePlattform. What is the easiest 
way to back up your VPN-1 NGX configuration? 
 
A. By copying the whole $FWDIR to another location. 
B. By using upgrade_export command in $FWDIR\bin directory. 
C. By executing a conf_merge with an objects_5_0.C from a new NGX installation. 
D. By copying the $FWDIR\conf and $FWDIR\lib directory to another location. 
E. By using native SecurePlatform backup utility from command line or in Web based 
interface. 
 
Answer: E 

 
QUESTION 23: 
 
 
In VPN-1 NGX, what happens if a Distinguished Name (DN) is NOT found in 
LDAP? 
 
A. VPN-1 NGX takes the common-name value from the Certificate subject, and searches 
the LDAP account unit for a matching user id. 
B. The Security Gateway uses the subject of the Certificate as the DN for the initial 
lookup. 
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C. If the first request fails or if branches do not match, NGX tries to map the identity to 
the user id attribute. 
D. When users authenticate with valid Certificates, the Security Gateway tries to map the 
identities with user registered in the external LDAP user database. 
E. VPN-1 NGX searches the internal database for the username. 
 
Answer: A 

 
QUESTION 24: 
 
 
Certkiller needs to create a backup of the routing, interface, and DNS configuration 
information from her VPN-1 NGX SecurePlatform Pro Security Gateway. Which 
backup-and-restore solution do you recommend for Certkiller? 
 
A. Policy Package management 
B. Database Revision Control 
C. Manual copies of the $FWDIR/conf directory 
D. SecurePlattform backup utilities 
E. Upgrade_export and upgrade_import commands 
 
Answer: D 
Upgrade_export and Upgrade_import do NOT 
backup/restore routing/dns information. This must be backed up using 
the Secureplatform utils. 
http://updates.checkpoint.com/fileserver/ID/5516/FILE/CheckPoint_NGX_SecurePlatform_SecurePlatformPro
_ 

 
QUESTION 25: 
 
 
Your Rule Base includes a Client Authentication rule, with partial authentication 
and standard sign on for HTTP, Telnet and FTP services. The rule was working, 
until this morning. Users are now not prompted for authentication, and their 
browser display "page cannot be displayed". In SmartView Tracker, you discover 
the HTTP connection is being dropped by the Security Gateway as the destination. 
What caused Client Authentication to fail? 
 
A. You added the Stealth Rule before the Client Authentication rule. 
B. You disabled VPN-1 NGX control connections in Global Properties. 
C. You enabled Static NAT on the problematic machines. 
D. The browsers' proxy settings have changed. 
E. You added a rule below the Client Authentication rule, blocking HTTP from the 
internal network. 
 
Answer: A 
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QUESTION 26: 
 
 
You are trying to enter a new user, group or organizational unit on an LDAP 
server, and you encounter the error message, "violates schema". To provide the 
BEST long-term security, you should: 
 
A. Restart the server. 
B. Import the schema, and enable schema checking. 
C. Recover the corrupt database. 
D. Turn off schema checking, and restart the SmartCenter Server. 
E. Turn off schema checking, and restart the LDAP server. 
 
Answer: B 

 
QUESTION 27: 
 
 
John is the Security Administrator for a public hospital. New health-care legislation 
requires logging for all traffic accepted through the perimeter Security Gateway. 
What must John do, to ensure implied rules meet the new requirement? 
 
A. Set the position of all implicit rules to "Before Last". 
B. Check the "Log Implied Rules" box in Global Properties. 
C. Clear all Global Properties check boxes, and use explicit rules instead. 
D. Install the "view Implicit Rules" package using SmartUpdate. 
E. Use the "Implicit Rules" predefined query in SmartView Tracker. 
 
Answer: B 
Check the "Log Implied Rules" Box in Global Properties. Definetally the answer Go to 
Global Properties\Firewall-1\Track(At the botom of the screeen)Tick Implied Rules 

 
QUESTION 28: 
 
 
You set up a mesh VPN Community, so your internal networks can access your 
partner's network, and vice versa. Your Security Policy encrypts only FTP and 
HTTP traffic through a VPN tunnel. All other traffic among your internal and 
partner networks is sent in cleartext. How do you configure the VPN Community? 
 
A. Put ftp and http in the Excluded services in the Community object. Then add a rule in 
the Security Policy to allow Any as the service, with the Community object in the VPN 
field. 
B. Disable "accept all encrypted traffic" in the Community, and add ftp and http services 
to the Security Policy, with that Community object in the VPN field. 
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C. Disable "accept all encrypted traffic", and put ftp and http in he Excluded services in 
the Community object. Add a rule in the Security Policy for services ftp and http, with 
the Community object in the VPN field. 
D. Enable "accept all encrypted traffic", but put ftp and http in the Excluded services in 
the Community. Add a rule in the Security Policy, with services ftp and http, and the 
Community object in the VPN field. 
 
Answer: B 

 
QUESTION 29: 
 
 
How do you view a Security Administrator's activities, using SmartConsole tools? 
 
A. With SmartView Status 
B. With SmartView Tracker in Audit mode 
C. With SmartView Tracker in Log mode 
D. With SmartView Monitor 
E. With SmartView Tracker in Active Mode 
 
Answer: B 

 
QUESTION 30: 
 
 
Certkiller is about to test some rule and object changes suggested in a VPN-1 NGX 
newsgroup. Which backup and restore solution should Certkiller use, to ensure she 
can restore her Security Policy to its previous configuration, after testing the 
changes? 
 
A. Policy Package management 
B. Database Revision Control 
C. Upgrade_export and upgrade_import commands 
D. Manual copies of the $FWDIR/conf directory 
E. SecurePlatform backup utilities 
 
Answer: B 

 
QUESTION 31: 
 
 
Your users are defined in a Windows 2000 Active Directory server. You must add 
LDAP users to a Client Authentication rule. Which kind of user group do you need 
in the Client Authentication rule? 
 
A. External-user group 
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B. ALLUSERS 
C. LDAP group 
D. LDAP account-unit group 
E. A group with generic* user 
 
Answer: C 

 
QUESTION 32: 
 
 
Ben is the Security Administrator for a university. Ben configured and installed a 
new Security Policy this morning. An hour after installing the new Security Policy, 
Ben began receiving complaints that Internet access was very slow. Ben called his 
Internet Service Provider, who asked Ben how much virtual memory his Security 
Gateway had. Which SmartConsole application should Ben use to answer this 
question? 
 
A. SmartView Status 
B. SmartLSM 
C. SmartView Tracker 
D. SmartUpdate 
E. SmartView Monitor 
 
Answer: E 

 
QUESTION 33: 
 
 
Jerry is concerned that a denial-of-service (DoS) attack may affect his VPN 
Communities. He decides to implement IKE DoS protection. Jerry needs to 
minimize the performance impact of implementing this new protection. Which of 
the following configurations is MOST appropriate for Jerry? 
 
A. Set Support IKE DoS protection from identified source to "Stateless", and Support 
IKE DoS protection from unidentified source to "None" 
B. Set Support IKE DoS protection from identified source to "None", and Support IKE 
DoS protection from unidentified source to "Stateless" 
C. Set Support IKE DoS protection from identified source to "Puzzles", and Support IKE 
DoS protection from unidentified sources to "Stateless" 
D. Set support IKE DoS protection from identified sources to "Puzzles", and Support IKE 
DoS protection from unidentified source to "Puzzles" 
E. Set support IKE DoS protection from identified sources to "Stateless", and Support 
IKE DoS protection from unidentified source to "Puzzles" 
 
Answer: E 
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Explanation: This is the default, and CheckPoint recommended. Refer to the 
VPN.pdf file on the CP CD, pg 34 & 35. 

 
QUESTION 34: 
 
 
Certkiller .com has two headquarters, one in London, one in New York. Each 
headquarter includes several branch offices. The branch offices only need to 
communicate with the headquarters in their country, not with each other, and only 
the headquarters need to communicate directly. What is the BEST configuration for 
VPN Communities among the branch offices and their headquarters, and between 
the two headquarters? 
 
A. VPN Communities comprised of three star Communities: The first one between New 
York headquarters and its branches. The second star Community is between London 
headquarters and its branches. The third star Community is between New York and 
London headquarters. 
B. VPN Communities comprised of two mesh Communities, one for each headquarters 
and their branch offices; one star Community, where New York is the center of the 
Community and London is the satellite. 
C. VPN Communities comprised of two star and one mesh Community; each star 
Community is set up for each site, with headquarters as the center of the Community and 
branches as satellites. The mesh Communities are between the New York and London 
headquarters. 
D. VPN Communities comprised of two mesh Communities for each headquarters and 
their branch offices; and one star Community, in which London is the center of the 
Community and New York is the satellite. 
E. VPN Communities comprised of three mesh Communities: one for London 
headquarters and its branches, one for New York headquarters and its branches, and one 
for London and New York headquarters. 
 
Answer: C 

 
QUESTION 35: 
 
 
When you change an implicit rule's order from "last" to "first" in global 
Properties, how do you make the change effective? 
 
A. Reinstall the Security Policy 
B. Close SmartDashboard, the reopen it 
C. Run cpstop and cpstart on the SmarCenter Gateway. 
D. Run cpstop and cpstart on the SmarCenter Server. 
E. Do nothing. The changes is made automatically. 
 
Answer: A 
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Explanation:  
Reinstall policy. When you make changes to a security policy(Implicit or explicit) you 
have toreinstall policy. 

 
QUESTION 36: 
 
 
Which VPN-1 NGX component displays the number of packets accepted, rejected, 
and dropped on a specific Security Gateway, in real time? 
 
A. SmartView Tracker 
B. SmartView Monitor 
C. SmartView Status 
D. SmartUpdate 
E. SmartDashboard 
 
Answer: B 
 
Explanation:  
The SmartView Monitor enables network administrators to monitor Check Point System 
Counters, traffic on an interface and QoS in real-time. Additionally it is able to create 
reports on past activities. In Report mode, reports can be made for Check Point System 
Counters as well as for traffic on an interface. 
When you decide to create traffic history reports in the SmartView Monitor, the reports 
creation process may affect the performance of the module. If you do not intend to use 
create traffic history reports, you should disable the Traffic options on this page. Other 
types of reports (such as Check Point System Counter reports) do not affect the 
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performance of the module significantly. 

 
 

QUESTION 37: 
 
 
Ilse manages a distributes VPN-1 NGX installation for a large bank. Ilse needs to know 
which Security Gateways have licenses that will expire within the next 30 days. 
Which SmartConsole application should Ilse use to gather this information? 
 
A. SmartUpdate 
B. SmartView Monitor 
C. SmartDashboard 
D. SmartView Tracker 
E. SmartView Status 
 
Answer: A 

 
QUESTION 38: 
 
 
Which VPN-1 NGX logs can you configure to send to DShield.org? 
 
A. Active and alert logs 
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B. Audit and alert logs 
C. Alert and user-defined alert logs 
D. SNMP and account logs 
E. Account and alert logs 
 
Answer: C 

 
QUESTION 39: 
 
 
Brianna has three servers located in a DMZ, using public IP addresses that need to 
be accessed by her internal networks. Brianna's internal network use class B IP 
addresses, per RFC 1918. Internal networks access the Internet, using Dynamic 
NAT behind the external IP address of her Security Gateway. What is the best way 
to configure access for the DMZ servers? 
 
A. Configure Manual NAT rules to translate the internal networks, when connecting to 
the DMZ servers. 
B. Configure Dynamic NAT for the DMZ interface of the Security Gateway. 
C. Configure Static NAT rules for the DMZ servers. 
D. Configure Manual NAT rules to translate the DMZ servers, when connecting to the 
internet. 
 
Answer: A 
 
Explanation:  
Between internal network and dmz network there's no need for NAT, because Security 
Gateway has routes for both so routing should be enough. 
So the Address Translation should look like this: 
Original PacketTranslated Packet 
Source Destination Service Source Destination Service 
internal_net dmz_netAny Original Original Original 

 
QUESTION 40: 
 
 
How do you prevent malware from scanning specific ports in SmartDefense? 
 
A. By enabling Malware Scan protection 
B. By enabling Malicious Code Protector 
C. By enabling Host port Scan 
D. By enabling Sweep Scan protection 
E. By enabling Network port scan 
 
Answer: D 
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Explanation: The question is tricky and a play on words, a 'sweep' is a scan on 
specific ports across multiple servers - which fits the answer. 

 
QUESTION 41: 
 
 
You have locked yourself out of SmartDashboard with the rules you just installed 
on your Security Gateway. Now you cannot access the SmartCenter Server or any 
SmartConsole tools, via SmartDashboard. How can you reconnect to 
SmartDashboard? 
 
A. Run fw unloadlocal on the Security Gateway. 
B. Run fw uninstall localhost on the Security Gateway. 
C. Run fw unlocklocal on the SmartCenter Server. 
D. Run cpstop on the SmartCenter Server. 
E. Run cpstop on the Security Gateway. 
 
Answer: A 

 
QUESTION 42: 
 
 
Doug wants to know who installed a Security Policy blocking all traffic from the 
corporate network. Which SmartView Tracker selection is best suited for this? 
 
A. SmartView Tracker Active tab 
B. SmartView Tracker Audit tab 
C. SmartView Tracker custom filter 
D. SmartVew Tracker Records pane 
E. SmartView Tracker log connections 
 
Answer: B 

 
QUESTION 43: 
 
 
Assume an intruder has compromised your current IKE Phase 1 and Phase 2 keys. 
Which of the following options will end the intruder's access, after the next Phase 2 
exchange occurs? 
 
A. SHA1 Hash Completion 
B. MD5 Hash Completion 
C. Phase 3 Key Revocation 
D. DES Key Reset 
E. Perfect Forward Secrecy 
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Answer: E 

 
QUESTION 44: 
 
 
Which security server can perform content-security tasks, but CANNOT perform 
authentication tasks? 
 
A. RLOGIN 
B. Telnet 
C. SMTP 
D. FTP 
E. HTTP 
 
Answer: C 

 
QUESTION 45: 
 
 
What does schema checking do? 
 
A. Issues Certificates, and register the Certificates with the VPN-1 NGX Internal 
Certificate Authority 
B. Maps LDAP objects to objects in the VPN-1 NGX objects.c file 
C. Provides topology downloads for SecuRemote and SecureClient users authenticated 
by an LDAP server 
D. Authenticates users attempting to access resources protected by a VPN-1 NGX 
Security Gateway 
E. Verifies that every object class, and its associated attributes, is defined in the directory 
schema 
 
Answer: E 

 
QUESTION 46: 
 
 
As a Security Administrator, you must configure anti-spoofing on Secure Gateway 
interfaces, to protect your internal networks. What is the correct anti-spoofing 
setting on interface ETH1 in this network diagram? 
NOTE: In the DMZ, mail server 192.168.16.10 is statically translated to the object 
"mail_valid", with IP address 210.210.210.3. FTP server 192.168.16.15 is statically 
translated to the object "ftp_valid", with IP address 210.210.210.5. 
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A. A group object that includes the 10.10.20.0/24 and 10.10.10.0/24 networks 
B. A group object that includes the 10.10.0.0/16 network object, mail_valid host, and 
FTP_valid host object 
C. A group object that includes the 10.10.10.0/24 and 192.168.16.0/24 networks 
D. A group object that includes the 192.168.16.0/24 and 10.10.0.0/16 networks 
E. A group object that includes the 10.10.0.0/16 and 192.168.16.0/24 networks, and 
mail_valid and ftp_valid host objects 
 
Answer: A 

 
QUESTION 47: 
 
 
When you use the Global Properties' default settings, which type of traffic will be 
dropped, if no explicit rule allows the traffic? 
 
A. IKE and rDP traffic 
B. Outgoing traffic originating from the Security gateway. 
C. SmartUpdate connections 
D. Firewall logging and ICA key-exchange information. 
E. RIP traffic 
 
Answer: E 

 
QUESTION 48: 
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By default, when you click File > Switch Active File from SmartView Tracker, the 
smartCenter Server: 
 
A. Purges the current log, and prompts you for the new log's mode. 
B. Prompts you to enter a file name, then saves the log file. 
C. Saves the current log file, names the log file by date and time, and starts a new log 
file. 
D. Opens a new window with a previously saved log file. 
E. Purges the current log file, and starts a new log file. 
 
Answer: C 

 
QUESTION 49: 
 
 
If you check the box "Use Aggressive Mode", in the IKE Properties dialog box: 
 
A. The standard six-packet IKE Phase 1 exchange is replaced by a three-packet exchange 
B. The standard three-packet IKE Phase 2 exchange is replaced by a six-packet exchange 
C. The standard six-packet IKE Phase 2 exchange is replaced by a three-packet exchange 
D. The standard three-packet IKE Phase 1 exchange is replaced by a six-packet exchange 
 
Answer: A 

 
QUESTION 50: 
 
 
Jordan's company is streaming training videos provided by a third party on the 
Internet. Jordan configures VPN-1 NGX, so that each department ONLY views 
webcasts specific to its department. Jordan created and configured the multicast 
groups for all interfaces, and configures them to "Drop all multicast packets except 
those whose destination is in the list". But no multicast transmissions are coming 
from the Internet. What is possible causes for the connection problem? 
 
A. Multicast groups are configured improperly on the external interface properties of the 
Security Gateway object. 
B. Anti-spoofing is enabled. VPN-1 NGX cannot pass multicast traffic, if anti-spoofing is 
enabled. 
C. Jordan did not create the necessary "to and through" rules, defining how VPN-1 NGX 
will handle the multicast traffic. 
D. VPN-1 NGX does not support multicast routing protocols and streaming media 
through the Security Gateway. 
E. The Multicast Rule is below the Stealth Rule. VPN-1 NGX can only pass multicast 
traffic, if the Multicast Rule is above the Stealth Rule. 
 
Answer: A 
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Not D: NGX doesn't support multicast? That's quite obviously not true. 
http://www.checkpoint.com/ngx/upgrade/top10.html 

 
QUESTION 51: 
 
 
Your SmartCenter Server fails and does not reboot. One of your remote Security 
Gateways, managed by the SmartCenter Server, reboots. What happens to that 
remote Gateway after reboot? 
 
A. Since the SmartCenter Server is not available, the remote Gateway cannot fetch the 
Security Policy. Therefore, all traffic is allowed through the Gateway. 
B. Since the SmartCenter Server is not available, the remote Gateway uses the local 
Security Policy, but does not log traffic. 
C. Since the SmartCenter Server is not available, the remote Gateway cannot fetch the 
Security Policy. Therefore, no traffic is allowed through the Gateway. 
D. Since the SmartCenter Server is not available to the remote Gateway, fetching the 
Security Policy and logging will both fail. 
E. The remote Gateway fetches the last installed Security Policy locally, and passes 
traffic normally. The Gateway will log locally, since the SmartCenter Server is not 
available. 
 
Answer: E 

 
QUESTION 52: 
 
 
Which component functions as the Internal Certificate Authority for VPN-1 NGX? 
 
A. SmartConsole 
B. SmartCenter Server 
C. Policy Server 
D. SmartLSM 
E. Security Gateway 
 
Answer: B 

 
QUESTION 53: 
 
 
Robert has configured a CIFS resource to allow access to the public partition of his 
company's file server, on \\erisco\goldenapple\files\public. Robert receives reports 
that users are unable to access the share, unless they use the file server's IP address. 
Which of the following is a possible cause? 
 
A. the CIFS resource is not configured to use Windows name resolution 
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B. Mapped shares are not configured to log. 
C. Null CIFS sessions are configured to be blocked 
D. Remote registry access is configured to be blocked. 
E. Access violations are not configured to log. 
 
Answer: A 

 
QUESTION 54: 
 
 
Barak is a Security Administrator for an organization that has two sites using pre-shared 
secrets in its VPN. The two sites are Oslo and London. Barak has just been 
informed that a new office is opening in Madrid, and he must enable all three sites 
to connect via the VPN to each other. Three Security Gateways are managed by the 
same SmartCenter Server, behind the Oslo Security Gateway. Barak decides to 
switch from pre-shared secrets to Certificates issued by the Internal Certificate 
Authority (ICA). After creating the Madrid gateway object with the proper VPN 
Domain, what are Barak's remaining steps? 

 
 
A. 1, 2, 3, 4 
B. 1, 2, 5 
C. 1, 2, 3, 5 
D. 1, 3, 4, 5 
E. 1, 2, 3, 4, 5 
 
Answer: C 
 
Explanation: Without installing the policy the new setting will not be applied. 
BTW it is not necessary/useful to change to traditional mode configuration. 

 
QUESTION 55: 
 
 
You want to establish a VPN, using Certificates. Your VPN will exchange 
Certificates with an external partner. Which of the following activities should you 
do first? 
 
A. Exchange a shared secret, before importing Certificates. 
B. Create a new logical-server object, to represent your partner's CA. 
C. Create a new server object, to represent your partner's Certificate Authority (CA) 
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D. Manually import your partner's Certificate Revocation List. 
E. Manually import your partner's Access Control list. 
 
Answer: C 

 
QUESTION 56: 
 
 
There is a Web server behind your perimeter Security Gateway. You need to 
protect the server from network attackers, who creates scripts that force your Web 
server to send user credentials or identities to other Web servers. Which box do you 
check in the Web Intelligence tab in SmartDashboard? 
 
A. Command Injection protection 
B. SQL Injection protection 
C. HTTP header format checking 
D. HTTP protocol inspection protection 
E. Cross Site Scripting protection 
 
Answer: E 
See screenshot from the actual Smartdefense description for Cross-site scripting defense: 

 
 

QUESTION 57: 
 
 
How do you control the maximum mail messages in a spool directory? 
 
A. In the SMTP resource object 
B. In the smtp.conf file on the SmartCenter Server 
C. In the gateway object's SMTP settings in the Advanced window 
D. In SmartDefense SMTP settings 
E. In the Security Server window in Global Properties 
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Answer: C 
It's an option in the SMTP security server settings from the gateway object. See 
screenshot: 

 
 

QUESTION 58: 
 
 
Quinton is the Security Administrator for a chain of retail stores. In a recent 
security newsletter, Quinton read about an attack where a client fools a server into 
sending large amount of data, using small packets. Quinton is concerned that this 
company's servers might be vulnerable to this type of attack. Which smartDefense 
option should Quinton use to protect the servers? 
 
A. Application Intelligence > DNS > Cache poisoning 
B. Network Security > Successive events > DoS 
C. Network Security > TCP > Small PMTU 
D. Application Intelligence > Microsoft Networks > File and Print Sharing 
E. Network Security > Denial of Service > LAND 
 
Answer: C 

 
QUESTION 59: 
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In SmartView Tracker, which rule shows when a packet is dropped due to 
anti-spoofing? 
 
A. Rule 999 
B. Rule 0 
C. Rule 1 
D. Cleanup Rule 
E. Stealth Rule 
 
Answer: B 
Rule 0 means the action was not taken because of a rule but rather for some other reason 
(for example, anti-spoofing or authentication was applied). 
Found @ http://www.checkpoint.com/support/technical/online_ug/logview.html 

 
QUESTION 60: 
 
 
Sonny is the Security Administrator for a company with a large call center. The 
management team in the center is concerned that employees may be installing and 
attempting to use peer-to-peer file-sharing utilities, during their lunch breaks. The 
call center's network is protected by an internal Security Gateway, configured to 
drop peer-to-peer file-sharing traffic. The call-center management team wants to 
know if the Security Gateway protecting the call center drops more packets than 
other internal Security Gateways in the corporate network. Which application 
should Sonny use, determine the number of packets dropped by each Gateway? 
 
A. SmartView Status 
B. SmartView Monitor 
C. SmartDashboad 
D. SmartView Tracker 
E. SmartUpdate 
 
Answer: B 
 
Explanation:  
The SmartView Monitor enables network administrators to monitor Check Point System 
Counters, traffic on an interface and QoS in real-time. Additionally it is able to create 
reports on past activities. In Report mode, reports can be made for Check Point System 
Counters as well as for traffic on an interface. 
When you decide to create traffic history reports in the SmartView Monitor, the reports 
creation process may affect the performance of the module. If you do not intend to use 
create traffic history reports, you should disable the Traffic options on this page. Other 
types of reports (such as Check Point System Counter reports) do not affect the 
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performance of the module significantly. 

 
 

QUESTION 61: 
 
 
Katie is the Security Administrator for an insurance company. Her manager gives 
Katie the following requirements for controlling DNS traffic: 
* Required Result #1: Accept domain name-over-TCP traffic (zone-transfer traffic). 
* Required Result #2: Log domain name-over-TCP traffic (zone-transfer traffic). 
* Desired Result #1: Accept domain name-over-UDP traffic (queries traffic) 
* Desired Result #2: Do not log domain name-over-UDP traffic (queries traffic) 
* Desired Result #3: Do not clutter the Rule Base, by creating explicit rules for 
traffic that can be controlled using Global Properties. 
Katie makes the following configuration changes, and installs the Security Policy: 
1. She selects the box "Accept Domain Name over TCP (Zone transfer)" in Global 
Properties. 
2. She selects the box "Accept Domain Name over UDP (Queries)" in Global 
Properties. 
3. She selects the box "Log Implied Rules" in Global Properties 
Does Katie's solution meet the required and desired results? 
 
A. The solution meets all required results, and none of the desired results. 
B. The solution does not meet the required results. 
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C. The solution meets all required and desired results. 
D. The solution meets the required results, and one of the desired results. 
E. The solution meets the required results, and two of the desired results. 
 
Answer: E 

 
QUESTION 62: 
 
 
David is a consultant for a software-deployment company. David is working at a 
customer's site this week. David's ask is to create a map of the customer's VPN 
tunnels, including down and destroyed tunnels. Which SmartConsole application 
will provide David with the information needed to create this map? 
 
A. SmartView Tracker 
B. SmartLSM 
C. SmartView Monitor 
D. SmartView Status 
E. SmartUpdate 
 
Answer: C 

 
QUESTION 63: 
 
 
Gail is the Security Administrator for a marketing firm. Gail is working with the 
networking team, to troubleshoot user complaints regarding access to 
audio-streaming material from the Internet. The networking team asks Gail to 
check he configuration settings for the perimeter Security Gateway. Which 
SmartConsole application should Gail use to check the configuration settings? 
 
A. SmartView Tracker 
B. SmartView Monitor 
C. SmartUpdate 
D. SmartDashboard 
E. SmartView Status 
 
Answer: D 

 
QUESTION 64: 
 
 
One of your remote Security Gateways suddenly stops sending logs, and you cannot 
install the Security Policy on the Gateway. All other remote Security Gateways are 
logging normally to the SmartCenter Server, and Policy installation is not affected. 
When you click the Test SIC status button in the problematic gateway object, you 
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receive an error message "unknown". What is the problem? 
 
A. The time on the SmartCenter Server's clock has changed, which invalidates the remote 
Gateway's Certificate. 
B. The remote Gateway's IP address has changed, which invalidates the SIC Certificate. 
C. The Security Gateway is NG with Application Intelligence, and the SmartCenter 
Server is NGX. 
D. The Internal Certificate Authority for the SmartCenter object has been removed from 
objects_5_0.c. 
E. There is no connection between the SmartCenter Server and the remote Gateway. 
Rules or routing may block the connection. 
 
Answer: E 

 
QUESTION 65: 
 
 
Frank wants to know why users on the corporate network cannot receive multicast 
transmissions from the Internet. A VPN-1 NGX Security Gateway protects the 
corporate network from the Internet. Which of the following is a possible cause for 
the connection problem? 
 
A. VPN-1 NGX does not support multicast routing protocols and streaming media 
through the Security Gateway. 
B. The Multicast Rule is below the Stealth Rule. VPN-1 NGX can only pass multicast 
traffic, it the Multicast Rule is above the Stealth Rule. 
C. Multicast restrictions are configured improperly on the external interface properties of 
the Security Gateway object. 
D. Anti-spoofing is enabled. VPN-1 NGX cannot pass multicast traffic, if anti-spoofing is 
enabled. 
E. Frank did not install the necessary multicast license with SmartUpdate, when 
upgrading the VPN-1 NGX. 
 
Answer: C 

 
QUESTION 66: 
 
 
You are concerned that a message may have been intercepted and retransmitted, 
thus compromising the security of the communications. You attach a code to the 
electronically transmitted message that uniquely identifies the sender. This code is 
known as a: 
 
A. Digital signature 
B. Tag 
C. Private key 



156-215 
 

Actualtests.com - The Power of Knowing 

D. AES flag 
E. Diffie-Helman verification 
 
Answer: A 

 
QUESTION 67: 
 
 
A user attempts authentication using SecureClient. The user's password is rejected, 
even though it is correctly defined in the LDAP directory. 
Which of the following is a valid cause? 
 
A. The LDAP server has insufficient memory 
B. The LDAP and Security Gateway databases are not synchronized. 
C. The SmartCenter Server cannot communicate with the LDAP server. 
D. The user has defined the wrong encryption scheme. 
E. The user is defined in both the NGX user database and the LDAP directory 
 
Answer: B 
 
Explanation: The LDAP and Security gateway data base are not synchronized. 

 
QUESTION 68: 
 
 
Select the correct statement about Secure Internal Communications (SIC) 
Certificates? 
SIC Certificates: 
 
A. for NGX Security Gateways are created during the SmartCenter Server installation. 
B. For the SmartCenter Server are created during the SmartCenter Server installation. 
C. Are used for securing internal network communications between the SmartView 
Tracker and an OPSEC device 
D. Decrease network security by securing administrative communication among the 
SmartCenter Servers and the Security Gateway 
E. Uniquely identify Check Point enabled machines; they have the same function as 
Authentication Certificates 
 
Answer: B 
 
Explanation: It is created at the smartcenterserver for the smartcenter server 
during installation. 

 
QUESTION 69: 
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Exhibit: *** MISSING *** 
Review the following rules and note the Client Authentication Action properties 
screen as displayed in the exhibit, 
After being authenticated by the Security Gateway, when a user starts an HPPT 
connection to a Web site, the user tries to FTP another site using the command line. 
What happens to the user? 
The... 
 
A. FTP session is dropped by the implicit Cleanup Rule. 
B. User is prompted from that FTP site only, and does not need to enter username and 
password for Client Authentication. 
C. FTP connection is dropped by rule 2. 
D. FTP data connection is dropped, after the user is authenticated successfully. 
E. User is prompted for authentication bye the Security Gateway again. 
 
Answer:  

 
QUESTION 70: 
 
 
Diffie-Hellman uses which type of key exchange? 
 
A. Adaptive 
B. Asymmetric 
C. Symmetric 
D. Static 
E. Dynamic 
 
Answer: B 

 
QUESTION 71: 
 
 
Certkiller's main internal network 10.10.10.0/24 allows all traffic to the Internet 
using Hide NAT. Certkiller also has a small network 10.10-.20.0/24 behind the 
internal router. Jack wants to configure the kernel to translate the source address 
only when network 10.10.20.0 tries to access the Internet for HTTP, SMTP, and 
FTP services. 
Which of the following configurations will allow this network to access Internet? 
 
A. Automatic Static NAT on network 10.10.20.0/24 
B. Manual Hide NAT rules for HTTP, FTP, and SMTP services for network 
10.10.20.0/24. 
C. Manual Static NAT rules for network 10.10.20.0/24, 
D. Automatic Hide NAT for network 10.10.20.0/24. 
E. No change is necessary. 
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Answer: B 
 
Explanation:  
It is specified that the network addresses are translated only when they try to access 
HTTP,SMTP and FTP. 
Original Packet Translated Packet 
No Source Destination Service Source Destination Service 
1 internal_net Any HTTP firewall(hide) Original Original 
2 internal_net Any FTP firewall(hide) Original Original 
3 internal_net Any SMTP firewall(hide) Original Original 

 
QUESTION 72: 
 
 
With SmartDashboard´s Smart Directory, you can create NGX user definitions on 
a(n) _____________ Server. 
 
A. NT Domain 
B. LDAP 
C. Provider-1 
D. SecureID 
E. Radius 
 
Answer: B 

 
QUESTION 73: 
 
 
Jens notices a large amount of traffic from a specific internal IP address. He needs 
to verify if it is a network attack, or a user's system infected with a worm. He has 
enabled Sweep Scan Protection and Host port scan in SmartDefense. Will Jens get 
all the information he needs from these actions? 
 
A. No. SmartDefense will only block the traffic, but it will not provide a detailed analysis 
of the traffic. 
B. No. SmartDefense will not block the traffic. The logs and alert can provide a further 
level information, but determining whether the attack is intentional or a worm requires 
further research by Jens. 
C. No. Jens also should set SmartDefense to quarantine the traffic from the suspicious IP 
address. 
D. Yes. SmartDefense will limit the traffic impact from the scans, and identify if the 
pattern of the traffic matches any known worms. 
E. No. To verify if this is a worm or an active attack, Jens should also enable TCP attack 
defenses. 
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Answer: B 

 
QUESTION 74: 
 
 
Which NGX feature or command provides the easiest path for Security 
Administrators to revert to earlier versions of the same Security Policy and objects 
configuration? 
 
A. cpconfig 
B. upgrade_export/upgrade_import 
C. Database Revision Control 
D. Dbexport/dbimport 
E. Policy Package management 
 
Answer: C 

 
QUESTION 75: 
 
 
How do you configure an NGX Security Gateway's kernel memory settings, without 
manually modifying the configuration files in $FWDIR\lib? By configuring: 
 
A. the settings on the Gateway object's Capacity Optimization screen 
B. the settings on the Global Properties Capacity Optimization screen 
C. the Settings on the Gateway object's Advanced screen 
D. the settings on the SmartCenter Server object's Advanced screen 
E. SmartDefense Kernel Defender options 
 
Answer: A 

 
QUESTION 76: 
 
 
Which of the following is NOT a feature or quality of a hash function? 
 
A. Encrypted with the sender's RSA private key, the hash function forms the digital 
signature. 
B. It is mathematically infeasible to derive the original message from the message digest. 
C. The hash function forms a two-way, secure communication. 
D. The hash function is irreversible. 
E. It is mathematically infeasible for two different messages to produce the same 
message digest. 
 
Answer: C 
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Explanation: The hash function does not provide a two way secure communication, 
it's simply a function which when used in conjuction with a digital certificate 
ensures the integrity and unique identity of a sender. 

 
QUESTION 77: 
 
 
You are a Security Administrator configuring Static NAT on an internal host-node 
object. You clear the box "Translate destination on client side", accessed from 
Global Properties > NAT settings > Automatic NAT. Assuming all other Global 
Properties NAT settings are selected, what else must be configured for automatic 
Static NAT to work? 
 
A. The NAT IP address must be added to the anti-spoofing group of the external 
Gateway interface 
B. Two address-translation rules in the Rule Base 
C. No extra configuring needed 
D. A proxy ARP entry, to ensure packets destined for the public IP address will reach the 
Security Gateway's external interface 
E. A static route, to ensure packets destined for the public NAT IP address will reach the 
Gateway's internal interface 
 
Answer: E 
 
Explanation:  
if you clear the box "Translate destination on client side" the nat will be performed on the 
internal interface side of your firewall, rather than the external interface and packets will 
not get to the firewalls internal interface as the routing on the firewall would send packets 
bound for public IP to the external interface. So you need to add a static route to point the 
nat rules public ip to the internal interface of the firewall so that the nat can be 
performed. 
From ChechkPoint Online Help: 
Translate destination on client side applies to packets originating at the client, with the 
server as its destination. Static NAT for the server is performed on the client side. 
In Check Point Gateways prior to version NG, Static NAT for the server ("Static 
Destination Mode NAT") was performed on the server side of the gateway, which 
required special handling for anti-spoofing and internal routing. 

 
QUESTION 78: 
 
 
Which encryption scheme provides "In-place" encryption? 
 
A. IKE 
B. Manual IPSec 
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C. DES 
D. SKIP 
E. AES 
 
Answer: C 
 
Explanation: DES (and FWZ1 and RC4) is an encryption algorithm that is used to 
encrypt the data portion of a packet. 
The relationship between the components of the encryption schemes, as implemented in 
FireWall-1, is described in the following table. 

 
Not B, D: Manual IPSec and SKIP are an examples of encapsulated encryption, where 
the entire packet is encrypted. 

 
QUESTION 79: 
 
 
After importing the NGX schema into an LDAP server, what should you enable? 
 
A. Schema checking 
B. Encryption 
C. UserAuthority 
D. ConnectControl 
E. Secure Internal Communications 
 
Answer: A 

 
QUESTION 80: 
 
 
Which ldif file must you modify to extend the schema of a Windows 2000 domain? 
 
A. In NGX you do not need to modify any .ldif file 
B. The appropriate .ldif file is located in the Security Gateway: 
$FWDIR/conf/ldif/Microsoft_ad_schema.ldif 
C. The appropriate .ldif file is located in the SmartCenter Server: 
$FWDIR/lib/ldap/schema_microsoft_ad.ldif 
D. The appropriate .ldif file is located in the Security Gateway: 
$FWDIR/lib/ldif/Microsoft_ad_schema.ldif 
E. The appropriate .ldif file is located in the SmartCenter Server: 
$FWDIR/conf/ldif/Microsoft_ad_schema.ldif 
 
Answer: C 
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Explanation: Page 226 of the SmartCenter_UserGuide.pdf from Check Point says 
"The definitions of all VPN-1 Pro attributes in LDIF format are contained in the file 
'scheme_microsoft_ad.ldif' located in $FWDIR/lib/ldap directory." 
http://www.checkpoint.com/support/technical/documents/docs_r61.html 
Also screenshot from SecurePlatform confirms this 

 
Not B, D, E: All of thefilenames/locations in answers B,D,E are invalid - it can't be those 

 
QUESTION 81: 
 
 
What is the reason for the Critical Problem notification in this SmartView Monitor 
example? 

 
 
A. Active real memory shortage on the Gateway 
B. No Security Policy installed on the Security Gateway 
C. Version mismatch between the SmartCenter Server and Security Gateway 
D. Time not synchronized between the SmartCenter Server and Security Gateway 
E. No Secure Internal Communications established between the SmartCenter Server and 
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Security Gateway 
 
Answer: B 

 
QUESTION 82: 
 
 
Your standby SmartCenter Server's status is collision. What does that mean, and 
how do you synchronize the Server and its peer? 
 
A. The standby and active Servers have two Internal Certificate Authority (ICA) 
Certificates. Uninstall and reinstall the standby Server. 
B. The active Server detected a keep-alive packet from the standby Server. 
C. The peer Server has not been properly synchronized. Manually synchronize both 
Servers again. 
D. The peer Server is more up-to-date. Manually synchronize both Servers again. 
E. The active SmartCenter Server and its peer have different Security Policies and 
databases. Manually synchronize the Servers, and decide which Server's configuration to 
overwrite. 
 
Answer: E 
Explanation; 
This description is taken from the help menu in SmartDashboard in an article titled "The 
Management High Availability Solution". 
The possible synchronization statuses are: 
(several other status codes) ... then 
Collision - the Active SmartCenter Server and its peer have different installed policies and 
databases. The administrator must perform manual synchronization and decide which of the SCSs 
to overwrite. 
In this case, both SmartCenter Server A and B have some information which is not synchronized 
with its peer. In order to remedy the collision state, one of the SmartCenter Servers will need to 
be overwritten. The SmartCenter Server which is found to have the dominant or significant 
changes should be the SmartCenter Server on which manual synchronization is initiated. 
At this point the system administrator needs to decide which of the SmartCenter Server's should 
become the Standby SCS, and change its status, if necessary. 

 
QUESTION 83: 
 
 
Sarah is the Security Administrator for Certkiller . Sarah has configured 
SmartDefense to block the CWD and FIND commands. Sarah installs the Security 
Policy, but the Security Gateway continues to pass the commands. Which of the 
following could be the cause of the problem? 
 
A. The Rule Base includes a rule accepting FTP to any source, from any destination. 
B. The SmartDefense > Application Intelligence > FTP Security Server screen does not 
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have the radio button set to "Configurations apply to all connections". 
C. The FTP Service Object > Advanced > Blocked FTP Commands list does not include 
CWD and FIND. 
D. The Web Intelligence > Application Layer > FTP Settings list is configured to allow, 
rather than exlude, CW and FIND commands. 
E. The Global Properties > Security Server > "Control FTP Commands" box is not 
checked. 
 
Answer: B 

 
QUESTION 84: 
 
 
Your NGX enterprise SmartCenter Server is working normally. However, you must 
reinstall the SmartCenter Server, but keep the SmartCenter Server configuration 
(for example, all Security Policies, databases, etc.) How would you reinstall the 
Server and keep its configuration? 
 
A. 1. Run the latest upgrade_export utility to export the configuration. 
2. Keep the exported file in the same location. 
3. Use SmartUpdate to reinstall the SmartCenter Server. 
4. Run upgrade_import to import the configuration. 
B. 1. Run the latest upgrade_export utility to export the configuration. 
2. Leave the exported .tgz file in $FWDIR. 
3. Install the priCertkiller SmartCenter Server on top of the current installation. 
4. Run upgrade_import to import the configuration. 
C. 1. Insert the NGX CD-ROM, and select the option to export the configuration into a 
.tgz file. 
2. Transfer the .tgz file to another networked machine. 
3. Uninstall all NGX packages, and reboot. 
4. Use the NGX CD-ROM to select the upgrade_import option to import the 
configuration. 
D. 1. Download the latest upgrade_export utility, and run it from $FWDIR\bin to export 
the configuration into a .tgz file. 
2. Transfer the .tgz file to another networked machine. 
3. Uninstall all NGX packages, and reboot. 
4. Install a new priCertkiller SmartCenter Server. 
5. Run upgrade_import to import the configuration. 
 
Answer: D 
 
Explanation:  
Note: correct path will be $FWDIR/bin/upgrade_tools 

 
QUESTION 85: 
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How can you reset Secure Internal Communications (SIC) between a SmartCenter 
and Security Gateway? 
 
A. Run the command fwm sic_reset to reinitialize the Internal Certificate Authority 
(ICA) of the SmartCenter Server. Then retype the activation key on the Security Gateway 
from SmartDashboard. 
B. From cpconfig on the SmartCenter Server, choose the Secure Internal Communication 
option and retype the activation key. Next, retype the same key in the gateway object in 
SmartDashboard and reinitialize Secure Internal Communications (SIC). 
C. From the SmartCenter Server's command line type fw putkey -p <shared key> <IP 
Address of SmartCenter Server>. 
D. From the SmartCenter Server's command line type fw putkey -p <shared key> <IP 
Address of Security Gateway>. 
E. Reinstall the Security Gateway. 
 
Answer: B 
 
Explanation:  
Note: The B option (Secure Internal Communication) is available in NG R55. We don't 
have something like this in NGX R60 or NGX R61. 
Incorrect answers: 
A: A deletes the certificates, although this would work it's not needed just to reset SIC. 
C,D,E are irrelevant. 

 
QUESTION 86: 
 
 
You have locked yourself out of SmartDashoard with the rules you just installed on 
your stand alone Security Gateway. Now you cannot access the SmartCenter Server 
or any SmartConsole tools via SmartDashboard. How can you reconnect to 
SmartDashboard? 
 
A. Run cpstop on the SmartCenter Server. 
B. Run fw unlocklocal on the SmartCenter Server. 
C. Run fw unloadlocal on the Security Gatewawy. 
D. Delete the $fwdir/database/manage.lock file and run cprestart. 
E. Run fw uninstall localhost on the Security Gateway. 
 
Answer: C 

 
QUESTION 87: 
 
 
Ellen is performing penetration tests against SmartDefense for her Web server 
farm. She needs to verify that the Web servers are secure against traffic hijacks. She 
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has activated the Cross-Site Scripting property. What other settings would be 
appropriate? Ellen: 
 
A. should also enable the Web intelligence > SQL injection setting. 
B. must select the "Products > Web Server" box on each of the node objects. 
C. should enable all settings in Web Intelligence. 
D. needs to configure TCP defenses such as "Small PMTU" size. 
E. needs to create resource objects for the web farm servers and configure rules for the 
web farm. 
 
Answer: B 

 
QUESTION 88: 
 
 
William is a Security Administrator who has added address translation for his 
internal Web server to be accessible by external clients. Due to poor network design 
by his predecessor, William sets up manual NAT rules for this server, while his FTP 
server and SMTP server are both using automatic NAT rules. All traffic from his 
FTP and SMTP servers are passing through the Security Gateway without a 
problem, but traffic from the Web server is dropped because of anti-spoofing 
settings. What is causing this? 
 
A. "Allow bi-directional NAT" is not checked in Global Properties. 
B. "Translate destination on client side" is not checked in Global Properties under 
"Manual NAT Rules". 
C. "Translate destination on client side" is not checked in Global Properties > Automatic 
NAT Rules. 
D. Routing is not configured correctly. 
E. Manual NAT rules are not configured correctly. 
 
Answer: B 
 
Explanation: Checkpoint asks this question for making relation between 
antispoofing and "translate destination on client site" properties.. Questions 
emphasizes this with the last sentence "., but the traffic from web server is dropped 
because of antispoofing settings..". 

 
QUESTION 89: 
 
 
You are a security consultant for a hospital. You are asked to create some type of 
authentication rule on the NGX Security Gateway, to allow doctors to update 
patients' records via HTTP from various workstations. Which authentication 
method should you use? 
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A. Client Authentication 
B. LDAP Authentication 
C. SecureID Authentication 
D. TACAS Authentication 
E. User Authentication 
 
Answer: E 

 
QUESTION 90: 
 
 
Certkiller is the Security Administrator for an online bookstore. Customers connect 
to a variety of Web servers to place orders, change orders, and check status of their 
orders. Mrs. Bill checked every box in the Web Intelligence tab, and installed the 
Security Policy, She ran penetration test through the Security Gateway, to 
determine if the Web servers were protected from cross-site scripting attacks. The 
penetration test indicated the Web servers were still vulnerable. Which of the 
following might correct the problem? 
 
A. The penetration software Certkiller is using is malfunctioning and is reporting a 
false-positive. 
B. Certkiller must create resource objects, and use them in the rule allowing HTTP 
traffic to the Web servers. 
C. Certkiller needs to check the "Products > Web Server" box on the host node objects 
representing his Web servers. 
D. Certkiller needs to check the "Web Intelligence" box in the SmartDefense > HTTP 
Properties. 
E. Certkiller needs to configure the Security Gateway protecting the Web servers as a 
Web server. 
 
Answer: C 
 
Explanation: Jack check everything on web intelligence and what she must to next is 
to check product-->web server to activate the rules. 

 
QUESTION 91: 
 
 
You create two Policy Packages for two NGX Security Gateways. For the first 
Policy Package, you select Security and Address Translation and QoS Policy. For 
the second Policy Package, you selected Security and Address Translation and 
Desktop Security Policy. In the first Policy Package, you enable host-based port 
scan from the SmartDefense tab. You save and install the policy to the relevant 
Gateway object. How is the port scan configured on the second Policy Package's 
SmartDefense tab? 
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A. Host-based port scan is disabled by default. 
B. Host-based port scan is enabled, because SmartDefense settings are global. 
C. Host-based port scan is enabled but it is not highlighted. 
D. There is no SmartDefense tab in the second Policy Package. 
 
Answer: B 
 
Explanation: Smart defense setting are global. 

 
QUESTION 92: 
 
 
A digital signature: 
 
A. Uniquely encodes the receiver of the key. 
B. Provides a secure key exchange mechanism over the Internet. 
C. Guarantees the authenticity and integrity of a message. 
D. Automatically changes the shared keys. 
E. Decrypts data to its original form. 
 
Answer: C 

 
QUESTION 93: 
 
 
You are setting up a Virtual Private Network, and must select an encryption 
scheme. Your data is extremely business sensitive and you want maximum security 
for your data communications. Which encryption scheme would you select? 
 
A. Tunneling mode encryption 
B. In-place encryption 
C. Either one will work without compromising performance 
 
Answer: A 
 
Explanation: It says you want maximum security, in this case you would use tunnel 
encryption which encrypts all of the packet not just the payload (more secure). C is 
wrong because tunnel encryption puts more of a processing overhead on the server 
than in-place encryption. 

 
QUESTION 94: 
 
 
You have just started a new job as the Security Administrator for Certkiller . Your 
boss has asked you to ensure that peer-to-peer file sharing is not allowed past the 
corporate Security Gateway. Where should you configure this? 
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A. SmartDashboard > SmartDefense 
B. SmartDashboard > WebDefense 
C. By editing the file $FWDIR/conf/application_intelligence.C 
D. SmartDashboard > Policy > Global Properties > Malicious Activity Detection 
E. SmartDashboard > Web Intelligence 
 
Answer: A 

 
QUESTION 95: 
 
 
Amy is configuring a User Authentication rule for the technical-support department 
to access an intranet server. What is the correct statement? 
 
A. The Security Server first checks if there is any rule tat does not require authentication 
for this type of connection. 
B. The User Authentication rule must be placed above the Stealth Rule. 
C. Once a user is first authenticated, the user will not be prompted for authentication 
again until logging out. 
D. Amy can only use the rule for Telnet, FTP, and rlogin services. 
E. Amy can limit the authentication attempts in the Authentication tab of the User 
Properties screen. 
 
Answer: A 
 
Explanation: Answer A is correct since you can have a rule below the User 
Authentication rule that allows the communication and the user will never get 
prompted for a login. 
Page 350 of the Official Student guide (NGX version 1.1) 
"The fact that a user successfully connects does not necessarily mean that the user was first 
authenticated. The authenticating Security Server first checks if the connection can be allowed by 
a rule that does not require authentication. If one exists, the user will be connected through the 
less-restrictive rule, bypassing the User Authentication rule." 
Not B: Rules with User or Session Authentication as the action can be placed below the 
Stealth Rule. All Client Authentication rules must be place above the Stealth rule, so they 
have access to the Secure Gateway. 
Checkpoint Student Handbook Official courseware NGX I Rev 156.215.1 page 382 
Not D:User Authentication supports HTTP and HTTPS along with Telnet, FTP and 
rlogin 

 
QUESTION 96: 
 
 
How can you unlock an administrator's account, which was been locked due to 
SmartCenter Access settings in Global Properties? 
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A. Type fwm lock_admin -ua from the command line of the SmartCenter Server. 
B. Clear the "locked" box from the user's General Properties in SmartDashboard. 
C. Type fwm unlock_admin -ua from the command line of the SmartCenter Server. 
D. Type fwm unlock_admin -ua from the command line of the Security Gateway. 
E. Delete the file admin.lock in the $FWDIR/tmp/ directory of the SmartCenter Server. 
 
Answer: A 
 
Explanation: You can unlock administrator just using "fwm lock_admin 
<options>" 
The options are: 
[-v] # view names of all locked Administrators 
[-u Administrator] # unlock a single Administrator 
[-ua] # unlock all locked Administrators 
Thus, the correct answer is A. 
Example: 
[Expert@cpmodule]# fwm lock_admin -ua 
Operation finished successfully 
[Expert@cpmodule]# fwm lock_admin -va 
No Administrators are currently locked. 
Not C: The command "fwm unlock_admin -ua" does not exist. 

 
QUESTION 97: 
 
 
How many administrators can be created during installation of the SmartCenter 
Server? 
 
A. Only one 
B. Only one with full access and one with read-only access 
C. As many as you want 
D. Depends on the license installed on the SmartCenter Server 
E. Specified in the Global Properties 
 
Answer: A 

 
QUESTION 98: 
 
 
Which SmartConsole tool verifies the installed Security Policy name? 
 
A. SmartView Status 
B. Eventia Reporter 
C. SmartView Server 
D. SmartUpdate 
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E. SmartView Tracker 
 
Answer: E 

 
QUESTION 99: 
 
 
Ilse manages a distributed NGX installation for Certkiller .com. Ilse needs to know 
which Security Gateways have licenses that will expire within the next 30 days. 
Which SmartConsole application should Ilse use to gather this information? 
 
A. SmartView Monitor 
B. SmartUpdate 
C. SmartDashboard 
D. SmartView Tracker 
E. SmartView Status 
 
Answer: B 

 
QUESTION 100: 
 
 
Herman is attempting to configure a site-to-site VPN with one of his firm's business 
partner. Herman thinks Phase 2 negotiations are failing. Which SmartConsole 
application should Herman use to confirm his suspicions? 
 
A. SmartUpdate 
B. SmartView Tracker 
C. SmartView Monitor 
D. SmartDashboard 
E. SmartView Status 
 
Answer: C 

 
QUESTION 101: 
 
 
How can you reset the password of the Security Administrator, which was created 
during initial installation of the SmartCenter Server on SecurePlatform? 
 
A. Launch cpconfig and select "Administrators". 
B. Launch SmartDashboard, click the admin user account, and overwrite the existing 
Check Point Password. 
C. Type cpm -a, and provide the existing administration account name. Reset the Security 
Administrator's password. 
D. Export the user database into an ASCII file with fwm dbexport. Open this file with an 



156-215 
 

Actualtests.com - The Power of Knowing 

editor, and delete the "Password" portion of the file. The log in to the account without 
password. You will be prompted to assign a new password. 
E. Launch cpconfig and delete the Administrator's account. Recreate the account with the 
same name. 
 
Answer: E 
 
Explanation:  
We have validated that Administrator account created during initial installation can not 
be managed by SmartDashboard. 

 
This is the account we have created during installation. 
The only way you can reset the password following instruction on answer E. 

 
QUESTION 102: 
 
 
What happens when you select File > Export from the SmartView Tracker menu? 
 
A. It is not possible to export an old log file, only save and switch in SmartView Tracker. 
B. Current logs are exported to a new *.log file. 
C. Exported log entries are still viewable in SmartView Tracker. 
D. Exported log entries are deleted from fw.log. 
E. Logs in fw.log are exported to a file that can be opened by Microsoft Excel. 
 
Answer: C 

 
QUESTION 103: 
 
 
Which type of TCP attack is a bandwidth attack, where a client fools a server into 
sending large amount of data, using small packets? 
 
A. SMURF 
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B. Small PMTU 
C. Host System Hogging 
D. LAN 
E. SYN-Flood 
 
Answer: B 

 
QUESTION 104: 
 
 
What is the proper command for exporting users in LDAP format? 
 
A. fw dbexport -f c:\temp\users.txt 
B. fw dbimport -f c:\temp\users.ldif -l -s "o=YourCity.com,c=YourCountry" 
C. fw dbimport -f c:\temp\users.ldap 
D. fw dbexport -f c:\temp\users.ldap -l -s 
E. fw dbexport -f c:\temp\users.ldif -l -s "o=YourCity.com,c=YourCountry" 
 
Answer: E 
 
Explanation:  
In check point Security administration NGX1 1.1 on page 417 in Chapter 9: LDAP User 
Management with SMARTDIRECTORY (official courseware/book) 
A typical command looks like the following example; 
Fwm dbexport -f c:\temp\users.ldif -l -s "o=yourcity.com,c=yourcountry" 
This command exports all attributes for all users to the users.ldif file, in LDF format. 
Export allows users to be imported into an LDAP server. 

 
QUESTION 105: 
 
 
Shauna is troubleshooting a Security Gateway that is dropping all traffic whenever 
the most recent Security Policy is installed. Working at the Security Gateway, 
Shauna needs to uninstall the Policy, but keep the processes running so she can see 
if there is an issue with the Gateway's firewall tables. Which of the following 
commands will do this? 
 
A. fw dbload 10.1.1.5 
B. fw unload 10.1.1.5 
C. cprestart 
D. fw tab -x -u 
E. cpstop 
 
Answer: D 
 
Explanation: tab -x -u displays kernel table content. 
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You want to uninstall not to load something. 
Incorrect answers: 
Not A, B: The question did not tell us anything about node 10.1.1.5. 
Not A: Definitely wouldn't be A as fw dbload is used to download user/network objects 
to specific targets, and it specifically says in the question she wants to uninstall the 
security policy. 

 
QUESTION 106: 
 
 
You have blocked an IP address via the Block Intruder feature of SmartView 
Tracker. How can you see the addresses you have blocked? 
 
A. In SmartView Status click the Blocked Intruder tab. 
B. Run fwm blocked_view. 
C. Run fw sam -va. 
D. Run fw tab -t sam_blocked_ips. 
E. In SmartView Tracker, click the Active tab, and the actively blocked connections 
display. 
 
Answer: D 

 
QUESTION 107: 
 
 
Your internal Web server in the DMZ has IP address 172.16.10.1/24. A particular 
network from the Internet tries to access this Web server. You need to set up some 
type of Network Address Translation (NAT), so that NAT occurs only from the 
HTTP service, and only from the remote network as the source. The public IP 
address for the Web server is 200.200.200.1. All properties in the NAT screen of 
Global Properties are enabled. 
Select the correct NAT rules, so NAT happens ONLY between "web_dallas" and 
the remote network. 
 
A. 1. Create another node object named "web_dallas_valid", and enter "200.200.200.1" 
in the General Properties screen. 
2. Create two manual NAT rules above the automatic Hide NAT rules for the 
172.16.10.0 network. 
3. Select "HTTP" in the Service column of both manual NAT rules. 
4. Enter an ARP entry and route on the Security Gateway's OS. 
B. 1. Enable NAT on the web_dallas object, select "static", and enter "200.200.200.1" in 
the General Properties screen. 
2. Specify "HTTP" in the automatic Static Address Translation rules. 
3. Create incoming and outgoing rules for the web_dallas server, for the HTTP service 
only. 
C. 1. Enable NAT on the web_dallas object, select "hide", and enter "200.200.200.1" for 
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the Hide NAT IP address. 
2. Specify "HTTP" in the Address Translation rules that are generated automatically. 
3. Create incoming and outgoing rules for the web_dallas server, for the HTTP service 
only. 
D. 1. Create another node object named "web_dallas_valid", and enter "200.200.200.1" 
in the General Properties screen. 
2. Create two manual NAT rules below the Automatic Hide NAT rules for network 
172.16.10.0, in the Address Translation Rule Base. 
3. Select "HTTP" in the Service column of both manual NAT rules. 
4. Enter an ARP entry and route on the Security Gateway's OS. 
 
Answer: A 
 
Explanation: Note Automatic NAT has defined order for placing rules into the rule 
base. The gateway installs Static NAT rules first, then Hide NAT rules. Within 
Static and NAT rules, node objects are first,then address ranges, and finally 
networks. 
See configuring _check_point_NGX_VPN-1_Firewall-1-R page 235 

 
QUESTION 108: 
 
 
Using SmartDefense how do you notify the Security Administrator that malware is 
scanning specific ports? By enabling: 
 
A. Network Port scan 
B. Host Port scan 
C. Malware Scan protection 
D. Sweep Scan protection 
E. Malicious Code Protector 
 
Answer: D 
 
Explanation: The question is tricky and a play on words, a 'sweep' is a scan on 
specific ports across multiple servers - which fits the answer. 

 
QUESTION 109: 
 
 
Jack's project is to define the backup and restore section of his organization's 
disaster recovery plan for his organization's distributed NGX installation. Jack 
must meet the following required and desired objectives: 
Required objective: The security policy repository must be backed up no less 
frequently than every 24 hours. 
Desired objective: The NGX components that enforce the Security Policies should 
be backed up no less frequently than once a week. 
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Desired objective: Back up NGX logs no less frequently than once a week. 
Administrators should be able to view backed up logs in SmartView Tracker. 
Jack's disaster recovery plan is as follows: 
Use the cron utility to run the upgrade_export command each night on the 
SmartCenter Servers. Configure the organization's routine backup software to back 
up the files created by the upgrade_export command. 
Configure the SecurePlatform backup utility to back up the Security Gateways 
every Saturday night. 
Use the cron utility to run the upgrade_export command each Saturday night on the 
Log Servers. Configure an automatic, nightly logexport. Configure the 
organization's routine backup software to back up the export log every night. 
Jack's plan: 
 
A. Meets the required objective but does not meet either desired objective. 
B. Meets the required objective and both desired objectives. 
C. Meets the required objective and only one desired objective. 
D. Does not meet the required objective. 
 
Answer: B 
 
Explanation: Logs can be viewed after exported. 

 
QUESTION 110: 
 
 
Anna is working at Certkiller .com, together with three other Security 
Administrators. Which SmartConsole tool should she use to check changes to rules 
or object properties other administrators made? 
 
A. SmartDashboard 
B. SmartView Tracker 
C. Eventia Tracker 
D. Eventia Monitor 
E. SmartView Monitor 
 
Answer: B 

 
QUESTION 111: 
 
 
When you find a suspicious connection from a problematic host, you want to block 
everything from that whole network, not just the host. You want to block this for an 
hour, but you do not want to add any rules to the Rule Base. How do you achieve 
this? 
 
A. Create a Suspicious Activity rule in SmartView Tracker. 
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B. Create a Suspicious Activity Rule in SmartView Monitor. 
C. Create an "FW SAM" rule in SmartView Monitor. 
D. Select "block intruder" from the Tools menu in the SmartView Tracker. 
 
Answer: B 
 
Explanation: They want to block the whole network not from specific node. 
It is indeed possible to block for an hour using the Suspicious Activity Rule. See 
screenshot: 

 
Not D: Block intruder block the source only. 

 
QUESTION 112: 
 
 
Your internal network is using 10.1.1.0/24. This network is behind your perimeter 
NGX VPN-1 Gateway, which connects to your ISP provider. How do you configure 
the Gateway to allow this network to go out to the Internet? 
 
A. Use automatic Static NAT for network 10.1.1.0/24. 
B. Use Hide NAT for network 10.1.1.0/24 behind the internal interface of your perimeter 
Gateway. 
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C. Use manual Static NAT on the client side for network 10.1.1.0/24 
D. Use Hide NAT for network 10.1.1.0/24 behind the external IP address of your 
perimeter Gateway. 
E. Do nothing, as long as 10.1.1.0 network has the correct default Gateway. 
 
Answer: D 

 
QUESTION 113: 
 
 
Which of these changes to a Security Policy optimizes Security Gateway 
performance? 
 
A. Using domain objects in rules when possible 
B. Using groups within groups in the manual NAT Rule Base 
C. Putting the least-used rule at the top of the Rule Base 
D. Logging rules as much as possible 
E. Removing old or unused Security Policies from Policy Packages 
 
Answer: A 
 
Explanation:  
Using domain objects in rules when possible usually reduce the number of rules and by 
that reduce processing time and improve performance. 

 
QUESTION 114: 
 
 
Nelson is a consultant. He is at a customer's site reviewing configuration and logs as 
a part of a security audit. Nelson sees logs accepting POP3 traffic, but he does not 
see a rule allowing POP3 traffic in the Rule Base. Which of the following is the most 
likely cause? The POP3: 
 
A. service is a VPN-1 Control Connection. 
B. rule is hidden. 
C. service is accepted in Global Properties. 
D. service cannot be controlled by NGX. 
E. rule is disabled. 
 
Answer: B 

 
QUESTION 115: 
 
 
When you hide a rule in a Rule Base, how can you then disable the rule? 
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A. Open the Rule Menu, and select Hide and View hidden rules. Select the rule, 
right-click, and select Disable. 
B. Uninstall the Security Policy, and the disable the rule. 
C. When a rule is hidden, it is automatically disabled. You do not need to disable the rule 
again. 
D. Run cpstop and cpstart on the SmartCenter Server, then disable the rule. 
E. Clear Hide from Rules drop-down menu, then right-click and select "Disable Rule(s)". 
 
Answer: E 
 
Explanation:  
Not A: A will only let you see the hidden rules but rules are still in hidden state. So it 
will not let you disable. 

 
QUESTION 116: 
 
 
Certkiller is the IT auditor for a bank. One of her responsibilities is reviewing the 
Security Administrators activity and comparing it to the change log. Which 
application should Certkiller use to view Security Administrator activity? 
 
A. NGX cannot display Security Administrator activity 
B. SmartView Tracker in Real-Time Mode 
C. SmartView Tracker in Audit Mode 
D. SmartView Tracker in Log Mode 
E. SmartView Tracker in Activity Mode 
 
Answer: C 

 
QUESTION 117: 
 
 
Andrea has created a new gateway object that she will be managing at a remote 
location. She attempts to install the Security Policy to the new gateway object, but 
the object does not appear in the "install on" box. Which of the following is the 
most likely cause? 
 
A. Andrea has created the object using "New Check Point > VPN-1 Edge Embedded 
Gateway" 
B. Andrea created the gateway object using the "New Check Point > Externally Managed 
VPN Gateway" option from the Network Objects dialog box. 
C. Andrea has not configured anti-spoofing on the interfaces on the gateway object. 
D. Andrea has not configure Secure Internal Communications (SIC) for the oject. 
E. Andrea created the Object using "New Check Point > VPN-1 Pro/Express Security 
Gateway" option in the network objects, dialog box, but still needs to configure the 
interfaces for the Security Gateway object. 
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Answer: B 
 
Explanation: Anti-spoofing configuration does not affect the ability to install the 
security policy on a gatway. No SIC configuration is required to install the security 
policy on a gateway. Both VPN-1 Edge gateways and VPN-1 Pro/Express gateways 
will appear in the list of selectable targets in SmartDashboard, but gateways created 
as externally managed will not (see screenshot) 

 
 

QUESTION 118: 
 
 
Certkiller is recently hired as the Security Administrator for Certkiller .com. Jack 
Bill's manager has asked her to investigate ways to improve the performance of 
the firm's perimeter Security Gateway. Certkiller must propose a plan based on the 
following required and desired results: 
Required Result #1: Do not purchase new hardware. 
Required Result #2: Use configuration changes the do not reduce security. 
Desired Result #1: Reduce the number of explicit rules in the Rule Base. 
Desired Result #2: Reduce the volume of logs. 
Desired Result #3: Improve the Gateway's performance. 
Proposed solution: 
* Replace all domain objects with network and group objects. 
* Check "Log implied rules" and "Accept ICMP requests" in Global Properties. 
* Use Global Properties, instead of explicit rules, to control ICMP, VRRP, and RIP. 
Does Certkiller's proposed solution meet the required and desired results? 
 
A. The solution meets all required and desired results. 
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B. The solution meets all required, and one of the desired results. 
C. The solution meets all required, and two of the desired results. 
D. The solution meets all required, and none of the desired results. 
E. The solution does not meet the required results. 
 
Answer: E 

 
QUESTION 119: 
 
 
You create implicit and explicit rules for the following network. The group object 
"internal-networks" include networks 10.10.10.0 and 10.10.20.0. Assume "Accept 
ICMP requests" is enabled as before last in the Global Properties. 

 
Based on these rules, what happens if you Ping from host 10.10.10.5 to a host on the 
Internet, by IP address? ICMP will be: 
 
A. dropped by rule 0 
B. dropped by rule 2, the Cleanup Rule 
C. accepted by rule 1 
D. dropped by the last implicit rule 
E. accepted by the implicit rule 
 
Answer: C 

 
QUESTION 120: 
 
 
What does schema checking do? 
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A. Authenticates users attempting to access resources protected by an NGX Security 
Gateway. 
B. Verifies that every object class, and its associated attributes, is defined in the directory 
schema. 
C. Maps LDAP objects to objects in the NGX objects_5_0.c files. 
D. Verifies the Certificate Revocation List for Certificate Validity. 
E. Provides topology downloads for SecuRemote and SecureClient users authenticated 
by an LDAP server. 
 
Answer: B 

 
QUESTION 121: 
 
 
Certkiller is about to test some rule and object changes suggested in an NGX 
newsgroup. Which backup and restore solution should Certkiller use, to ensure she 
can most easily restore her Security Policy to its previous configuration, after 
testing the changes? 
 
A. SecurePlatform backup utilities 
B. Manual copies of the $FWDIR/conf directory 
C. Upgrade_export and upgrade_import commands 
D. Policy Package management 
E. Database Revision Control 
 
Answer: E 

 
QUESTION 122: 
 
 
You want VPN traffic to match packets from internal interfaces. You also want the 
traffic to exit the Security Gateway, bound for all site-to-site VPN Communities, 
including Remote Access Communities. 
How should you configure the VPN match rule 
 
A. internal_clear>All-GwToGw 
B. Communities>Communities 
C. Internal_clear>External_Clear 
D. Internal_clear>Communities 
E. Internal_clear>All_communities 
 
Answer: E 

 
QUESTION 123: 
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Review the following rules and note the Client Authentication Action properties 
screen, as shown in the exhibit. 

 
After being authenticated by the Security Gateway when a user starts an HTTP 
connection to a Web site the user tries to FTP to another site using the command 
line. What happens to the user? 
The.... 
 
A. FTP session is dropprd by the implicit Cleanup Rule. 
B. User is prompted from the FTP site only, and does not need to enter username nad 
password for the Client Authentication. 
C. FTP connection is dropped by rule 2. 
D. FTP data connection is dropped, after the user is authenticated successfully. 
E. User is prompted for authentication by the Security Gateway again. 
 
Answer: B 

 
QUESTION 124: 
 
 
What is the command to see the licenses of the Security Gateway Certkiller from 
your SmartCenter Server? 
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A. print Certkiller  
B. fw licprint Certkiller  
C. fw tab -t fwlic Certkiller  
D. cplic print Certkiller  
E. fw lic print Certkiller  
 
Answer: D 
 
Explanation:  
cplic print - prints details of Check Point licenses on the local machine. On a 
Module, this command will print all licenses that are installed on the local 
machine - both Local and Central licenses. 
P456, . 
NG COMMAND LINE INTERFACE 
Advanced Technical Reference Guide - NG FP3 

 
QUESTION 125: 
 
 
Ophelia is the security Administrator for a shipping company. Her company uses a 
custom application to update the distribution database. The custom application 
includes a service used only to notify remote sites that the distribution database is 
malfunctioning. The perimeter Security Gateways Rule Base includes a rule to 
accept this traffic. Ophelia needs to be notified, via atext message to her cellular 
phone, whenever traffic is accepted on this rule. Which of the following options is 
MOST appropriate for Ophelia's requirement? 
 
A. User-defined alert script 
B. Logging implied rules 
C. SmartViewMonitor 
D. Pop-up API 
E. SNMP trap 
 
Answer: A 

 
QUESTION 126: 
 
 
Which of the following is the final step in an NGXbackup? 
 
A. Test restoration in a non-production environment, using the upgrade_import command 
B. Move the *.tgz file to another location 
C. Run the upgrade_export command 
D. Copy the conf directory to another location 
E. Run the cpstop command 
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Answer: B 
 
Explanation:  

 
427, Check Point Security Administration NGX I Student Handbook 

 
QUESTION 127: 
 
 
Which mechanism is used to export Check Point logs to third party applications? 
 
A. OPSE 
B. CPLogManager 
C. LEA 
D. SmartViewTracker 
E. ELA 
 
Answer: C 
Explanation; Check Point has made an API (Application Programming Interface) 
available for these companies to use to communicate with Check Point's product line.The 
SDK (Software Development Kit) requires knowledge of the C programming language. 
The SDK contains software to integrate with the following interfaces: 
? CVP The Content Vectoring Protocol allows antivirus solutions to talk to FireWall-1. 
? UFP The URI Filtering Protocol allows Web filtering to integrate. 
? LEA The Log Export API enables you to export log files to third-party log servers. 
? ELA The Event Logging API allows Check Point to receive logs from third-party 
software. 
338, Configuring Check Point NGX VPN-1/FireWall-1, Syngress, 1597490318 

 
QUESTION 128: 
 
 
In NGX, what happens if a Distinguished Name (ON) is NOT found in LADP? 
 
A. NGX takes the common-name value from the Certificate subject, and searches the 
LADP account unit for a matching user id 
B. NGX searches the internal database for the username 
C. The Security Gateway uses the subject of the Certificate as the ON for the initial 
lookup 
D. If the first request fails or if branches do not match, NGX tries to map the identity to 
the user id attribute 
E. When users authenticate with valid Certificates, the Security Gateway tries to map the 
identities with users registered in the extemal LADP user database 
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Answer: D 
 
Explanation:  
Retrieving Information from a SmartDirectory (LDAP) server 
When a Gateway requires user information for authentication purposes, it searches 
for this information in three different places: 
1 The first place that is queried is the internal users database. 
2 If the specified user is not defined in this database, the Gateway queries the 
SmartDirectory (LDAP) servers defined in the Account Unit one at a time, and 
according to their priority. If for some reason the query against a specified 
SmartDirectory (LDAP) server fails, for instance the SmartDirectory (LDAP) 
connection is lost, the SmartDirectory (LDAP) server with the next highest priority 
is queried. If there is more than one Account Unit, the Account Units are queried 
concurrently. The results of the query are either taken from the first Account Unit 
to meet the conditions, or from all the Account Units which meet the conditions. The 
choice between taking the result of one Account Unit as opposed to many is a matter 
of Gateway configuration. 
3 If the information still cannot be found, the Gateway uses the external users 
template to see if there is a match against the generic profile. This generic profile 
has the default attributes applied to the specified user. 

 
QUESTION 129: 
 
 
Which command allows you to view the contents of an NGX table? 
 
A. fw tab -s - 
B. fw tab -t - 
C. fw tab -u - 
D. fw tab -a - 
E. fw tab -x - 
 
Answer: B 
 
Explanation:  
fw tab -t - is correct. 
Note: fw tab -s - fw tab -s will give you the kernel table counts. 

 
QUESTION 130: 
 
 
The following is cphaprobstate command output from a New Mode High 
Availability cluster member: 
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Which machine has the highest priority? 
 
A. 192.168.1.2,since its number is 2 
B. 192.168.1.1,because its number is 1 
C. This output does not indicate which machine has the highest priority 
D. 192.168.1.2, because its state is active 
 
Answer: B 

 
QUESTION 131: 
 
 
What do you use to view an NGX Security Gateway's status, including CPU use, 
amount of virtual memory, percent of free hard-disk space, and version? 
 
A. SmartLSM 
B. SmartViewTracker 
C. SmartUpdate 
D. SmartViewMonitor 
E. SmartViewStatus 
 
Answer: D 

 
QUESTION 132: 
 
 
Which of the following commands is used to restore NGX configuration 
information? 
 
A. cpcontig 
B. cpinfo-i 
C. restore 
D. fwm dbimport 
E. upgrade_import 
 
Answer: E 

 
QUESTION 133: 
 
 
Which of the following commands shows full synchronizalion status? 
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A. cphaprob -i list 
B. cphastop 
C. fw ctl pstat 
D. cphaprob -a if 
E. fw hastat 
 
Answer: C 

 
QUESTION 134: 
 
 
Which VPN Community object is used to configure VPN routing within the 
SmartDashboard? 
 
A. Star 
B. Mesh 
C. Remote Access 
D. Map 
 
Answer: A 

 
QUESTION 135: 
 
 
If you are experiencing LDAP issues, which of the following should you check? 
 
A. Secure lnternal Cornrnunicalions(SIC) 
B. VPN tunneling 
C. Overlapping VPN Domains 
D. NGX connectivity 
E. VPN Load Balancing 
 
Answer: D 

 
QUESTION 136: 
 
 
Which operating system is not supported byVPN-1 SecureClient? 
 
A. IPS0 3.9 
B. Windows XP SP2 
C. Windows 2000 Professional 
D. RedHat Linux 7 0 
E. MacOS X 
 
Answer: A 
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QUESTION 137: 
 
 
Which Check Point QoS feature issued to dynamically allocate relative portions of 
available bandwidth? 
 
A. Guarantees 
B. Differentiated Services 
C. Limits 
D. Weighted Fair Queueing 
E. Low Latency Queueinq 
 
Answer: D 

 
QUESTION 138: 
 
 
You are running a VPN-1 NG with Application Intelligence R54 SecurePlatform 
VPN-1 Pro Gateway. The Gateway also serves as a Policy Server. When you run 
patch add cd from the NGX CD, what does this command allow you to upgrade? 
 
A. Only VPN-1 Pro Security Gateway 
B. Both the operating system (OS) and all Check Point products 
C. All products, except the Policy Server 
D. On~ the patch utility is upgraded using this command 
E. Only the OS 
 
Answer: B 

 
QUESTION 139: 
 
 
Amanda is compiling traffic statistics for Certkiller .com's Internet activity during 
production hours. How could she use SmartView Monitor to find this information? 
By 
 
A. using the "Traffic Counters" settings and SmartView Monitor to generate a graph 
showing the total HTTP traffic for the day 
B. -monitoring each specific user's Web traffic use. 
C. Viewing total packets passed through the Security Gateway 
D. selecting the "Tunnels" view, and generating a report on the statistics 
E. configuring a Suspicious Activity Rule which triggers an alert when HTTP traffic 
passes through the Gateway 
 
Answer: A 
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QUESTION 140: 
 
 
Certkiller is the Security Administrator for a software-development company. To 
isolate the corporate network from the developer's network, Certkiller installs an 
internal Security Gateway. Jack wants to optimize the performance of this Gateway. 
Which of the following actions is most likely to improve the Gateway's 
performance? 
 
A. Remove unused Security Policies from Policy Packages 
B. Clear all Global Properties check boxes, and use explicit rules 
C. Use groups within groups in the manual NAT Rule Base 
D. Put the least-used rules at the top of the Rule Base 
E. Use domain objects in rules, where possible 
 
Answer: D 
 
Explanation:  
This is usually reduces the number of rules and by that reduce processing time and 
improve performance. 
Not A: smart center server Policy Packages can NOT affect the gateway performance 

 
QUESTION 141: 
 
 
Certkiller is the Security Administrator for a chain of grocery stores. Each grocery 
store is protected by a Security Gateway. Certkiller is generating a report for the 
information-technology audit department. The report must include the name of the 
Security Policy installed on each remote Security Gateway, the date and time the 
Security Policy was installed, and general performance statistics (CPU Use, average 
CPU time, active real memory, etc.). 
Which SmartConsole application should Certkiller use to gather this information? 
 
A. SmartUpdate 
B. SmartView Status 
C. SmartView Tracker 
D. SmartLSM 
E. SmartView Monitor 
 
Answer: E 

 
QUESTION 142: 
 
 
How can you reset Secure Internal Communications (SIC) between a SmartCenter 
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Server and Security Gateway? 
 
A. Run the command fwm sic_reset to reinitialize the Internal Certificate Authority 
(ICA) of the SmartCenter Server. Then retype the activation key on the 
Security-Gateway from SmartDashboard 
B. From cpconfig on the SmartCenter Server, choose the Secure Internal Communication 
option and retype the actrvation key Next, retype the same key in the gateway object in 
SmartDashboard and reinitialize Secure Internal Communications (SIC) 
C. From the SmartCenter Server's command line type fw putkey -p <shared key>- <IP 
Address of SmartCenter Server>-. 
D. From the SmartCenter Server's command line type fw putkey -p <shared key>- <IP 
Address of security Gateway>-. 
E. Re-install the Security Gateway 
 
Answer: B 

 
QUESTION 143: 
 
 
Which NGX feature or command allows Security Administrators to revert to earlier 
versions of the Security Policy without changing object configurations? 
 
A. upgrade_export/upgrade_import 
B. Policy Package management 
C. fwm dbexport/fwm dbimport 
D. cpconfig 
E. Database Revision Control 
 
Answer: B 

 
QUESTION 144: 
 
 
Certkiller is the Security Administrator for Certkiller .com's large geographically 
distributed network. The internet connection at one of her remote sites failed during 
the weekend, and the Security Gateway logged locally for over 48 hours. Certkiller 
is concerned that the logs may have consumed most of the free space on the 
Gateway's hard disk. 
Which SmartConsole application should Certkiller use, to view the percent of free 
hard-disk space on the remote Security Gateway? 
 
A. SmartView Status 
B. SmartView Tracker 
C. SmartUpdate 
D. SmartView Monitor 
E. SmartLSM 
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Answer: D 

 
QUESTION 145: 
 
 
Certkiller is recently hired as the Security Administrator for a public relations 
company. Certkiller's manager has asked her to investigate ways to improve the 
performance of the firm's perimeter Security Gateway. Certkiller must propose a 
plan based on the following required and desired results 
Required Result #1: Do not purchase new hardware 
Required Result #2: Use configuration changes that do not reduce security 
Desired Result #1: Reduce the number of explicit rules in the Rule Base 
Desired Result #2: Reduce the volume of logs 
Desired Result #3: Improve the Gateway's performance 
Proposed Solution: 
Certkiller recommends the following changes to the Gateway's configuration: 
1. Replace all domain objects with network and group objects. 
2. Stop logging Domain Name over UDP (queries) 
3. Use Global Properties, instead of explicit rules, to control ICMP. VRRP, and RIP. 
Does Certkiller's proposed solution meet the required and desired result s? 
 
A. The solution meets the required results, and two of the desired results 
B. The solution does not meet the required results 
C. The solution meets all required results, and none of the desired results 
D. The solution meets all required and desired results 
E. The solution meets the required results, and one of the desired results 
 
Answer: A 

 
QUESTION 146: 
 
 
What is a Consolidation Policy? 
 
A. The collective name of the Security Policy, Address Translation, and SmartDefense 
Policies 
B. The specific Policy used by Eventia Reporter to configure log-management practices 
C. The state of the Policy once installed on a Security Gateway 
D. A Policy created by Eventia Reporter to generate logs 
E. The collective name of the logs generated by Eventia Reporter 
 
Answer: B 

 
QUESTION 147: 
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To change an existing ClusterXL cluster object from Multicast to Unicast mode, 
what configuration change must be made? 
 
A. Change the cluster mode to Unicast on the cluster object Reinstall the Security Policy 
B. Reset Secure Internal Communications (SIC) on the cluster-member objects. Reinstall 
the Security Policy 
C. Run cpstop and cpstart, to reenable High Availability on both objects. Select Pivot 
mode in cpconfig 
D. Change the cluster mode to Unicast on the cluster-member object 
E. Switch the internal network's default Security Gateway to the pivot machine's IP 
address 
 
Answer: A 

 
QUESTION 148: 
 
 
Which command line interface utility allows the administrator to verify the name 
and timestamp of the Security Policy currently installed on a firewall module? 
 
A. fw stat 
B. fw ver 
C. fw cog 
D. fw print 
E. fw ctl 
F. fw printlic 
G. fw ctl pstat 
 
Answer: A 
 
Explanation: fw stat showing the name of the security gateway and also the the date 
and time 

 
QUESTION 149: 
 
 
When logging into SmartDashboard for the second time, what information is no 
longer requested? 
 
A. User Name 
B. Password 
C. Finger verification 
D. SmartCenter Server IP 
 
Answer: C 
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Explanation:  
Finger verification - it's requested just one time when you opening first the 
smartdashboard, after you chose accept it's not seen again. 

 
QUESTION 150: 
 
 
You want to implement Static Destination NAT in order to provide external, 
Internet users access to an internal Web Server that has a reserved (RFC 1918) IP 
address. You have an unused valid IP address on the network between your 
Security Gateway and ISP router. You control the router that sits between the 
external interface of the firewall and the Internet. 
What is an alternative configuration if proxy ARP cannot be used on your Security 
Gateway? 
 
A. Publish a proxy ARP entry on the internal web server instead of the firewall for the 
valid IP address. 
B. Place a static route on the router from the valid IP address to the firewall's external 
address. 
C. Place a static route on the router from the valid IP address to the internal web server. 
D. Publish a proxy ARP entry on the router from the valid IP address to the firewall's 
external address. 
 
Answer: B 
 
Explanation:  
Place a static route on the router from the valid IP address to the firewall's external 
address, because the NAT performed at the external interface. 

 
QUESTION 151: 
 
 
When launching SmartDashboard, what information is required to log into VPN-1 
NGX? 
 
A. Password, SmartCenter Server IP 
B. User Name, SmartCenter Server IP, certificate fingerprint file 
C. Password, SmartCenter Server IP, LDAP Server 
D. User Name, Password, SmartCenter Server IP 
 
Answer: D 
 
Explanation:  
When launching the smartdashboard it's request user name and password and smartcenter 
server IP. 
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Not B: It can't be B because if you use certificate fingerprint file it's doesn't request the 
user name just the password. 

 
QUESTION 152: 
 
 
Your current security scenario gives you the option to choose between a stand-alone 
installation or a distributed installation. 
Which of the following factors would cause you to decide in favour of the 
stand-alone installation? 
 
A. You are required to use Clientless VPN. 
B. You are required to use Windows as operating system. 
C. You are required to install HFA's on the Security Gateway via SmartUpdate. 
D. You are required to use few hardware resources as possible. 
 
Answer: D 
 
Explanation:  
You are required to use few resources as possible, because distributed installation request 
at lease two machines, one for the security gateway and the second for the smartcenter 
server, while standalone installation request just one machine, since you can install is as 
SPLAT, also it's can't be B because you can install it at any operation system except 
IPOs. 

 
QUESTION 153: 
 
 
You are a Security Administrator configuring Static NAT on an internal host-node 
object. You clear the box "Translate destination on client side", accessed from 
Global Properties > NAT settings > Automatic NAT. Assuming all other Global 
Properties NAT settings are selected, what else must be configured for automatic 
Static NAT to work? 
 
A. The NAT IP address must be added to the anti-spoofing group of the internal Gateway 
interface 
B. Two address-translation rules in the Rule Base 
C. No extra configuring needed 
D. A proxy ARP entry, to ensure packets destined for the public IP address will reach the 
Security Gateway's external interface 
E. A dynamic route, to ensure packets destined for the public NAT IP address will reach 
the Gateway's internal interface 
 
Answer: A 
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Explanation:  
It must be added to the anti-spoofing other it will be dropped. 

 
QUESTION 154: 
 
 
You just installed a new Web server in the DMZ that must be reachable from the 
Internet. 
You create a manual Static NAT rule as follows: 
Source: Any 
Destination: web_public_IP 
Service: Any 
Translated Source: original 
Translated Destination: web_private_IP 
Service: original 
"web_public_IP" is the node object that represents the public IP address of the new 
Web server. 
"web_private_IP" is the node object that represents the new Web site's private IP 
address. You enable all settings from the Global Properties > NAT. 
When you try to browse the Web server from the Internet, you see the error "page 
cannot be displayed". 
Which of the following is NOT a possible reason? 
 
A. There is no Security Policy defined that allows HTTP traffic to the protected Web 
server. 
B. There is no ARP table entry for the public IP address of the protected Web server. 
C. There is no route defined on the Security Gateway for the public IP address to the 
private IP address of the Web server. 
D. There is an ARP entry on the Gateway but the settings "Merge Manual proxy ARP" 
and "Automatic APR configuration" are enabled in Global Properties. The Security 
Gateway ignores manual ARP entries. 
 
Answer: C 
 
Explanation:  
There is NO STATIC ROUTE - it's can't be the reason, because the NAT doing it 
automatically, we don't need any static route. 

 
QUESTION 155: 
 
 
Select the correct statement about Secure Internal Communications (SIC) 
Certificates? 
SIC Certificates: 
 
A. may be used for securing internal network communications between the Security 
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Gateway and an OPSEC device. 
B. for the SmartView Tracker are created during the SmartCenter Server installation. 
C. for NGX Security Gateways are created during the SmartCenter Server installation. 
D. decrease network security by securing administrative communication among the 
SmartCenter Servers and the Security Gateway 
 
Answer: A 
 
Explanation:  
Not B: the sic created during installation for the smartcenter server in the smartcenter 
server and not for the tracker. 
Not C: certificates for the NGX security gateways and any other communicating 
components, are created via a simple initialization from the smartconsole and not during 
installation! 

 
QUESTION 156: 
 
 
What settings in the "Track" field of your rules would you use to configure what 
types of information are sent to Dshield.org? 
Depending on how: 
 
A. the Logs and Masters settings for the SmartCenter Server object, rules with tracking 
set to Log or None. 
B. SmartDefense > DShield Storm Center is configured, rules with tracking set to Alerts 
or User Defined Alerts. 
C. Web Intelligence > Information Disclosure is configured, rules with tracking set to 
User Defined Alerts or SNMP trap. 
D. The Global Properties is configured, in the Log and Alerts section, rules with tracking 
set to Account or SNMP trap. 
 
Answer: B 
 
Explanation:  
You can find it at smartdefense DShieldStorm - you must configure it first as alert or user 
defined at the track rule. 

 
QUESTION 157: 
 
 
VPN-1 NGX uses ____________ to retrieve the Interface Name, IP Address, and 
Network Mask when an administrator clicks the GET button in the Interfaces tab 
of an Externally Managed VPN Gateway object. 
 
A. URI 
B. Ioctl 
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C. SNMP 
D. Control Connection 
 
Answer: C 
 
Explanation:  
VPN-1 NGX uses (not users - fix it at the question) SNMP to retrieve it. 

 
QUESTION 158: 
 
 
Certkiller .com has a small Check Point installation which includes one Windows 
2003 server working as SmartConsole and a second server running SPLAT working 
as both SmartCenter server and the Security Gateway. 
This is an example of: 
 
A. Hybrid Installation 
B. StandAlone Installation 
C. Unsupported Configuration 
D. Distribution Installation 
 
Answer: B 
 
Explanation:  
Standalone installation because the windows server work as smartconsole (just like any 
other client) that included the smartview monitor, tracker, dashboard etc and doesn't work 
like gateway or smartcenter server and the second server is SPLAT! 

 
QUESTION 159: 
 
 
Which of the following encryption modes causes the greatest increase in packet size? 
 
A. Triple-DES 
B. In-place encryption 
C. Diffie-Hellman 
D. Tunneling mode 
 
Answer: D 
 
Explanation:  
Tunneling mode - this encryption method encrypts the entire packet (header's + data 
packet). 

 
QUESTION 160: 
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Spoofing is a method of: 
 
A. Hiding your firewall from unauthorized users. 
B. Disguising an illegal IP address behind an authorized IP address through Port Address 
Translation. 
C. Detecting people using false or wrong authentication logins. 
D. Making packets appear as if they come from on IP address different from the sender's 
IP. 
 
Answer: D 
 
Explanation:  
The spoofing is method of making packets appear as if they come from one ip address 
different from the senders ip. 

 
QUESTION 161: 
 
 
You are configuring SmartDefense to block the CWD and FIND commands. What 
should you do before you install the Security Policy to keep the Security Gateway 
from continuing to pass commands. 
 
A. Delete the rule accepting FTP to any source, and from any destination from the Rule 
Base. 
B. Set the radio button on the SmartDefense > Application Intelligence > FTP Security 
Server seen to "Configurations apply to all connections". 
C. Check the Global Properties > Security Server > "Control FTP Commands" box. 
D. Include CWD and FIND in the FTP Service Object > Advanced > Blocked FTP 
Commands list. 
 
Answer: B 
 
Explanation:  
It can't be A because It's will drop all FTP traffic, and it's can't be C because the security 
server is under smartdefense, you can't find it under global properties, and it's cant be D 
because you can't add it to the FTP service object, answer B is the best choice. 

 
QUESTION 162: 
 
 
UDP packets are delivered if they are.... 
 
A. a legal response to an allowed request on the inverse UDP ports and IP 
B. bypassing the kernel by the "forwarding layer" of ClusterXL 
C. allowed by the SAM dynamic table 
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D. a stateful ACK to a valid SYN-SYN/ACK on the inverse UDP ports and IP 
Answer. A 
 
Explanation: Best answer is A - because it's not d - udp doesn't have ACK just tcp 
and it's not c or b because its doesn't relevant to SAM or ClusterXL. 

 
QUESTION 163: 
 
 
What rule is designed as a catchall to eliminate all traffic, unless specifically 
allowed. 
 
A. Reject 
B. Cleanup 
C. Anti-spoofing 
D. Stealth 
 
Answer: B 
 
Explanation: Cleanup rule is the drop any any rule. 

 
QUESTION 164: 
 
 
Whencconfiguring Anti-Spoofing on the Security Gateway object interfaces, which 
of the following is NOT a valid NGX Topology configuration? 
 
A. Any 
B. External 
C. Not Defined 
D. Specific 
 
Answer: A 
 
Explanation:  
The methods that we have are external and internal (Not defined, Specific) so the answer 
should be "ANY". 

 
QUESTION 165: 
 
 
Which of the following are authentication methods that VPN-1 NGX uses to validate 
connection attempts? Select the response below that includes the most complete list 
of valid authentication methods. 
 
A. Connection, Proxied, Session 
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B. Connection, User, Client 
C. User, Client, Session 
D. Proxied, User, Dynamic, Session 
 
Answer: C 
 
Explanation:  
NGX uses three methods of authentication, user, client and session. 

 
QUESTION 166: 
 
 
Certkiller .com enforces a strict change control policy, which of the following would 
be best to quickly drop an attacker's specific active connection? 
 
A. Intrusion Detection System (IDS) policy install 
B. SAM - block intruder feature of SmartView tracker 
C. Change the Rule Base and install the policy to all security gateways 
D. SAM - Suspicious Activity Rules feature of SmartView Monitor 
 
Answer: B 
 
Explanation:  
The question talks about attacker specific connection and not a general connection type 
that generic SAM rule would block. The only tool that able to block specific connection 
is the block feature in the SmartView Tracker. 
The block intruder future is based on the SAM feature, you can see that each time you 
block connection you see the connection on the sam_blocked_ips table (by running fw 
tab -t sam_blocked_ips command). 
In addition checkpoint explains that in page 144 of the 
CheckPoint_R65_SmartCenter_AdminGuide.pdf: 
"The Active mode of SmartView Tracker allows you to shut out intruders, by selecting 
the connection you've identified as intrusive and blocking one of the following. 
Block Intruder uses SAM to perform the block action." 

 
QUESTION 167: 
 
 
NAT can NOT be configured on which of the following objects? 
 
A. Address Range 
B. Gateway 
C. Host 
D. HTTP Logical Server 
 
Answer: D 
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Explanation:  
You can do NAT to address range, host and gateway. 

 
QUESTION 168: 
 
 
VPN-1 NGX supports User Authentication for which of the following services? 
Select the response below that contains the most complete list of supported services. 
 
A. SMTP, FTP, HTTP, TELNET 
B. FTP TELNET 
C. SMTP, FTP, TELNET 
D. FTP, HTTP, TELNET 
 
Answer: D 
 
Explanation:  
User authentication is used for ftp, telnet, rlogin, http and https - D is the best answer. 

 
QUESTION 169: 
 
 
You work as a Security Administrator at Certkiller .com. Certkiller .com maintains 
several IKE VPNs. Executives at Certkiller want to know which mechanism Check 
Point VPN-1 Pro uses to guarantee the authenticity and integrity of messages. 
Which technology should you explain to the executives? 
 
A. Digital Signatures 
B. Key Exchange Protocols 
C. Application Intelligence 
D. Certificate Revocation Lists 
 
Answer: B 
 
Explanation:  
Use MASH that is Key exchange protocol. 

 
QUESTION 170: 
 
 
You work as Security Administrator at Certkiller .com. You must refresh the Client 
Authentication authorization time-out with every new connection from the same 
source IP that was originally authorized by the rule. How do you do this? 
 
A. Enable the "Refreshable Timeout" in SmartDefense. 
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B. Enable the "Refreshable Timeout" setting, in the gateway object's Authentication 
screen. 
C. Enable the "Refreshable Timeout", in the Global Properties Authentication screen. 
D. Enable the "Refreshable Timeout" setting, in the Limit tab of the Client 
Authentication Action properties screen 
E. Enable the "Refreshable Timeout", in the user object's Authentication screen. 
 
Answer: D 
 
Explanation:  
You can do it at the limit TAB. 

 
QUESTION 171: 
 
 
Exhibit: 

 
Review the following rules. Assume domain UDP is enabled in the implied rules. 
What happens when a user from the internal network tries to browse to the Internet 
using HTTP? 
 
A. user's connection is dropped by the last implied rule. 
B. User can go to the Internet, without being prompted for authentication. 
C. User is promted three times before connecting to the Internet successfully. 
D. User can connect to the Internet successfully after being authenticated successfully. 
 
Answer: B 
 
Explanation:  
According to checkpoint student guide, "User Authentication chapter" (page 350 on 
revision RSNGX001.1): 
"The fact that a user successfully connects does not necessarily mean that the user was 
first authenticates. The authenticating security server first checks if the connection can be 
allowed by a rule that does not requires authentication. If one exists, the user will be 
connected through the less restrictive rule, bypassing the user authentication rule." 

 
QUESTION 172: 
 
 
Jeremy manages sites in Tokyo, Calcutta and Dallas, from his office in Chicago. He 
is trying to create a report for management, detailing the current software level of 
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each Security Gateway and their average CPU usage. He also wants to create a 
proposal outline, listing the most cost-effective way to upgrade his Gateways. Which 
two SmartConsole applications should Jeremy use, to create his report and outline? 
 
A. SmartView Tracker and SmartView Monitor 
B. SmartView Monitor and SmartUpdate 
C. SmartDashboard and SmartLSM 
D. SmartDashboard and SmartView Tracker 
E. SmartLSM and SmartUpdate 
 
Answer: B 

 
QUESTION 173: 
 
 
What of the following NGX SmartView views will display a popup warning 
regarding performance implications on the Security Gateway caused by using this 
log feature? 
 
A. All Records Query 
B. Account Query 
C. Audit tab 
D. Active Tab 
 
Answer: D 

 
QUESTION 174: 
 
 
Once installed, the VPN-1 NGX kernel resides directly below what layer of the 
TCP/IP stack? 
Note: Application is the top and Physical is the bottom of the IP stack. 
 
A. Transport 
B. Network 
C. Data link 
D. Session 
 
Answer: B 
 
Explanation:  
The kernel sits above the datalink and the physical layer so it's below the network layer. 

 
QUESTION 175: 
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Which of the following objects is a valid source in an Authentication rule? 
 
A. User_group@Network 
B. User@Any 
C. User@Network 
D. Host@Any 
 
Answer: B 

 
QUESTION 176: 
 
 
You are working with multiple Security Gateways that enforce a common set of 
rules. To minimize the number of policy packages, which one of the following would 
you choose? 
 
A. Install a separate local SmartCenter Server and SmartConsole for each remote 
Security Gateway. 
B. Create a separate Security Policy Package for each remote Security Gateway and 
specify "Install On Gateways." 
C. Run separate SmartDashboard instances to login and configure each Security Gateway 
directly. 
D. Create a single Security Policy Package with "Install on....Target" defined whenever a 
unique rule is required for a specific gateway. 
 
Answer: D 

 
QUESTION 177: 
 
 
What information is found in the Security Policy audit log? 
 
A. Rule author 
B. Top used QOS rule 
C. TCP source port 
D. TCP handshake average duration 
 
Answer: A 

 
QUESTION 178: 
 
 
Which VPN-1 NGX would you use to see the number of packets accepted since the 
last policy install? 
 
A. SmartView Status 
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B. SmartView Tracker 
C. SmartView Monitor 
D. SmartDashboard 
 
Answer: C 
 
Explanation:  
You can find it at smartview monitor 

 
QUESTION 179: 
 
 
If the LDAP scheme is not updated on the LDAP server, which Check Point user 
settings are stored locally in the Check Point user template? 
 
A. Time settings, Authentication Type, Location settings 
B. Location settings, Authentication type, Password 
C. Password, Authentication Type, Time Settings 
D. Authentication type, Time settings, Password 
 
Answer:  

 
QUESTION 180: 
 
 
A Security Policy has several database versions. What configuration remains the 
same no matter which version a Security Policy is using? 
 
A. Objects_5_0.c 
B. Rule Bases_5_0.fws 
C. fwauth.NDB 
D. Internal Certificate Authority (ICA) certificate 
 
Answer: D 
 
Explanation:  
Because a, b and c is data files that changes at each version only the ICA remain the 
same. 

 
QUESTION 181: 
 
 
VPN-1 NGX's INSPECT Engine inserts itself into the kernel between which two 
layers of the OSI model? 
 
A. Physical and Data 
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B. Presentation and Application 
C. Data and Network 
D. Session and Transport 
 
Answer: C 
 
Explanation:  
The kernel is above the datalink and below the network layers. 

 
QUESTION 182: 
 
 
Which of the following types of Attacks blocks a SYN packet in which the source 
address and port are the same the destination? 
 
A. LAND 
B. Viruses 
C. SMURF 
D. Ping of death 
 
Answer: A 
 
Explanation:  
The LAND attack involves sending a spoofed TCP SYN packet (connection initiation) 
with the target host's IP address and an open port as both source and destination. 

 
QUESTION 183: 
 
 
Exhibit: 

 
Study the exhibit carefully. 
The Internal Certificate Authority (ICA) is corrupt on your SmartCenter Server. 
The server is installed on a SecurePlatform machine in the Certkiller .com home 
office. You use IP address 10.1.1.1. You need to have management connectivity 
restored to a Security Gateway on a second SecurePlatform computer, which plan 
to ship to another Administrator at a Certkiller .com hub office. 
What is the correct order for restoring management connectivity on the Gateway 
before shipping it? 
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A. 1, 2, 3, 4, 5 
B. 1, 3, 2, 4, 5 
C. 2, 1, 4, 5 
D. 1, 2, 3, 4 
E. 2, 3, 1, 4, 5 
 
Answer: C 
 
Explanation:  
Although the Internal Certificate Authority (ICA) has become corrupt, the Security 
Policy and Objects Database have not. As the connectivity needs to be restored (as 
opposed to created new), the gateway object does not need to be defined as it will already 
be present within the database; instead, it will only need to have its SIC reset due to the 
corruption of the IC 
A. Therefore the correct sequence is... 
1. Reset SIC on SmartCenter Server to regenerate the IC 
A. (Step 2) 
2. Reset SIC on the Gateway and enter new SIC activation key (Step 1) 
3. Edit the Gateway object in SmartDashboard and re-initialise communication with the 
server using the same Activation Key already defined on the Gateway. (Step 4) 
4. Push a policy to ensure it is communicating correctly. (Step 5) 

 
QUESTION 184: 
 
 
Certkiller .com has customers connecting to a variety of Web servers to place or 
change orders, and check order status. You ran penetration tests through the 
Security Gateway, to determine if the Web servers were protected from a recent 
series of cross-site scripting attacks. The penetration testing indicated the Web 
servers were still vulnerable. You have enabled every protection in the Web 
Intelligence branch, configured the protections to apply to selected web servers, and 
installed the Security Policy. 
What else might you do to reduce the vulnerability? 
 
A. The penetration software you are using is malfunctioning and is reporting a 
false-positive. 
B. Check the "Web Intelligence" box in the SmartDefense > HTTP Protocol Inspection. 
C. Configure the Security Gateway protecting the Web servers as a Web server. 
D. Check the "Products > Web Server" box on the host node objects representing your 
Web servers. 
 
Answer: D 
 
Explanation:  
You should check the web server no the host node object, you'll get then more granular 
options. 
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QUESTION 185: 
 
 
Which of the following are considerations when determining Rule Base order? 
 
A. Grouping rules by date of creation 
B. Adding SAM rules at the top of the Rule Base 
C. Placing frequently accessed rules before less frequently accessed rules 
D. Grouping SmartDefense rules with dynamic drop rules 
 
Answer: C 
 
Explanation:  
Placing frequently accesses rule before less. 

 
QUESTION 186: 
 
 
In a distributed management environment, the administrator has removed all 
default check boxes from the Policy: Global Properties: Firwall Tab. Explicit rules 
were created to allow policy installs, policy fetches, and logging. After several 
months, the administrator has decided to re-establish SIC. 
What port(s) should be opened for establish SIC? 
 
A. FW1_ica_pull and FW1_ica_push 
B. None. SIC is established over the FW1 service used for policy installs. 
C. FW1_CPRID 
D. CPMI 
 
Answer: A 
 
Explanation:  
The pull and push ports. 

 
QUESTION 187: 
 
 
The Accounting Department is in the process of transferring a file via FTP from the 
bank. Which SmartView Tracker feature would show you the total bytes 
transferred so far on this connection? 
 
A. Audit log 
B. Active log 
C. Account Query 
D. Byte-Count Query 
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Answer: B 

 
QUESTION 188: 
 
 
Which of the following statements BEST describes Check Point's HIDE Translation 
Method? 
 
A. Many-to-one NAT which implements PAT (Port Address Translation) for 
accomplishing both Source and Destination IP address translation. 
B. Translates many source IP addresses into one source IP address. 
C. One-to-one NAT which implements PAT (Port Address Translation) for 
accomplishing both Source and Destination IP address translation. 
D. Translates many destination IP addresses into one destination IP address. 
 
Answer: B 
 
Explanation: Translates many source IP address into one source IP address. 

 
QUESTION 189: 
 
 
You are the firewall administrator with one SmartCenter Server managing three 
different firewalls. 
The SmartView Monitor's status display of one of the firewalls shows a computer 
icon with an "!" over it. Which of the following is the most likely cause? 
 
A. The firewall has been halted. 
B. The Rule Base is unable to resolve the IP address. 
C. The "Destination" object has been defined as external. 
D. The firewall is unprotected; no security policy is loaded. 
 
Answer: D 
 
Explanation: No security policy is loaded - you can validate it by running the fw 
unloadlocal command at the security gateway. 

 
QUESTION 190: 
 
 
The Get Address button, found on the Host Object - General Properties page, will 
retrieve what? 
 
A. The IP address 
B. The domain name 
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C. The fully qualified domain name 
D. The Mac address 
 
Answer: A 

 
QUESTION 191: 
 
 
Which of the following uses the same key to decrypt as it does to encrypt? 
 
A. Symmetric encryption. 
B. Certificate-based encryption 
C. Dynamic encryption 
D. Asymmetric encryption 
 
Answer: A 
 
Explanation: Symmetric encryption, in which the same key is used to encrypt and 
decrypt data is also called shared-key encryption. Symmetric encryption is 
primarily used for faster encryption performance. 

 
QUESTION 192: 
 
 
Which rule should be the Cleanup Rule in the Rule Base? 
 
A. Last. It explicitly drops otherwise accepted traffic. 
B. First. It explicitly accept otherwise dropped traffic. 
C. Before Last, followed by the Stealth Rule. 
D. Last. It serves as logging function before the implicit Drop. 
 
Answer: D 
 
Explanation: Without the Cleanup Rule, traffic not matching any of the rule base 
would be implicitly dropped. However, it is good practice to include a cleanup rule 
to serve as a logging function to log traffic that would otherwise be dropped. 

 
QUESTION 193: 
 
 
Exhibit: 
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You have three servers located in a DMZ, using private IP addresses. You want 
internal users from 10.10.10.x to access the DMZ servers by public IP addresses. 
Internal_net 10.10.10.x is configured for Hide NAT behind the Security Gateway's 
external interface. 
What is the best configuration for 10.10.10.x users to access the DMZ servers, using 
the DMZ servers' public IP addresses? 
 
A. Configure manual static NAT rules to translate the DMZ servers, when the source is 
the internal network 10.10.10.x. 
B. Configure Hide NAT for 10.10.10x behind DMZ's interface, when trying to access 
DMZ servers. 
C. Configure Hide NAT for the DMZ network behind the DMZ interface of the Security 
Gateway, when connection to internal network 10.10.10.x 
D. Configure manual static NAT rules to translate the DMZ servers, when connecting to 
the Internet. 
 
Answer: A 
 
Explanation:  
In order for the 10.10.10.x users to access the DMZ servers, using the DMZ servers' 
public IP addresses, manual static NATs are required to translate the destination 
addresses of the DMZ public IP addresses to their actual private addresses specifically 
for traffic sourced from the internal 10.10.10.x network. This way, internal users can 
access the DMZ servers without affecting their access to the internet using the hide NAT 
of the Security Gateway's external interface. 

 
QUESTION 194: 
 
 
NAT can be implemented on which of the following lists of objects? 
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A. Host, Network 
B. Host, User 
C. Domain, Network 
D. Network, Dynamic Object 
 
Answer: A 
 
Explanation: NAT can be implemented to address range, host and network. 

 
QUESTION 195: 
 
 
What utility is used to gather important troubleshooting information from an NGX 
VPN-1 Gateway? 
 
A. fwinfo 
B. srmonitor 
C. cpinfo 
D. sysinfo 
 
Answer: C 
 
Explanation: Using this command: cpinfo -o ticketnumber.txt (where 
"ticketnumber" is the SR number assigned to the issue by Check Point Technical 
Support) retrieves the necessary information required by Technical Support for 
analysis. 

 
QUESTION 196: 
 
 
How does the Get Address button, found on the Host Object - General Properties 
page retrieve the address? 
 
A. SNMP Get 
B. Address resolution (ARP, RARP) 
C. Route Table 
D. Name resolution (hosts file, DNS, cache) 
 
Answer: D 
 
Explanation: SmartDashboard looks up the name entered in the Host Node - 
General Properties 'Name:' field to discover the IP address. It will look up its cache, 
local host file or a DNS server to resolve the name. 
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QUESTION 197: 
 
 
Where can an administrator configure the notification action in the event of a policy 
install time change? 
 
A. SmartView Monitor: Global Thresholds 
B. SmartView Tracker: Audit Log 
C. SmartDashboard: Security Gateway Object: Advanced Properties Tab 
D. SmartDashboard: Policy Package Manager 
 
Answer: A 
 
Explanation:  
actions for parameters that are monitored by SmartView Monitor can be set in 
SmartView Monitor > Gateways > Threshold Settings > Global Thresholds. Actions can 
include None, Log, Alert, Mail, SNMPTrap or user defined alerts. See Screenshot below. 
 

 
 

QUESTION 198: 
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What is the Manual Client Authentication TELNET port? 
 
A. 22 
B. 800 
C. 265 
D. 900 
E. 21 
F. 259 
G. 260 
H. 264 
I. 23 
 
Answer: F 
 
Explanation: We have two methods of client authentication, using explorer at port 
900 and telnet at port 259. 

 
QUESTION 199: 
 
 
You are a firewall administrator with one SmartCenter Server managing three 
different firewalls. One of the firewalls does NOT show up in the dialog box when 
attempting to install a Security Policy. 
Which of the following is a possible cause? 
 
A. The license for this specific firewall has expired. 
B. The firewall is not listed in the "policy installation targets" screen for this policy 
package. 
C. The license has failed to synch with the SmartCenter Server for 60 minutes. 
D. The firewall object has been created but SIC has not yet been established. 
 
Answer: B 
 
Explanation:  
The security gateway will not be shown in case the security gateway is not selected in the 
policy target screen. 
Not "A" - since the failure would shown only when installation process is started and not 
in the selection menu. 

 
QUESTION 200: 
 
 
Which of the following describes the behavior of a NGX Security Gateway? 
 
A. All traffic is expressly permitted by explicit rules. 
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B. IP protocol types as "secure" are allowed by default. ICMP, TCP, UDP sessions are 
inspected. 
C. TELNET, HTTP, and SMTP are allowed by default through SmartDefense rules 
D. Traffic not explicitly permitted is dropped. 
 
Answer: D 
 
Explanation: We have implicit rule known as cleanup rule that dropped all traffic 
that not explicitly allowed. 

 
QUESTION 201: 
 
 
Exhibit: 

 
Your perimeter Security Gateway's external IP is 200.2000.200.3. Your network is 
displayed in the exhibit. 
Required: Allow only network 192.168.10.0 and 192.168.20.0 to get out to Internet, 
using 200.200.200.5. Assume you enable all the settings in the NAT page of Global 
Properties. 
How do you achieve this requirement using the minimum number of NAT rules and 
objects? 
 
A. Create two network objects: 192.168.10.0/24 and 192.168.20.0/24. Add the two 
network objects to a group object. Create a manual NAT rule like the following: Original 
Source - group object; Destination - any; Service - any; Translated source - 
200.200.200.5. Destination - original; Service - original. 
B. Create network objects for 192.168.10.0/24 and 192.168.20.0/24. Enable Hide NAT 
on both network objects, using 200.200.200.5 as hiding IP address. 
C. Create a network object 192.168.0.0/16. Enable Hide NAT on the NAT page. Enter 
200.200.200.5 as hiding IP address. Add an ARP entry for 200.200.200.5 for the MAC 
address of 200.200.200.3. 
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D. Create an Address Range object, starting from 192.168.10.1 to 192.168.20.254. 
Enable Hide NAT on the NAT page of the Address range object. Enter Hiding IP address 
200.200.200.5. 
 
Answer: D 

 
QUESTION 202: 
 
 
In a distributed management environment, the administrator has removed all 
default check boxes from the Policy: Global Properties: Firewall Tab. In order for 
Security Gateways to send logs to the SmartCenter Server an explicit rule must be 
created to allow the Security Gateway to communicate to the SmartCenter Server 
on port ........... 
 
A. 22 
B. 800 
C. 255 
D. 265 
E. 900 
F. 256 
G. 21 
H. 259 
I. 260 
J. 264 
K. 257 
 
Answer: K  

 
QUESTION 203: 
 
 
Your enable Hide NAT on the network object 10.1.1.0 behind the Security 
Gateway's external interface. You browse www. Certkiller .com from host 10.1.1.10 
successfully. You enable a log on the rule that allows 10.1.1.0 to exit the network. 
How many log entries do you see for that connection in the SmartView Tracker? 
 
A. Two, inbound 
B. Only one, inbound 
C. Two, one for outbound, one for inbound 
D. Only one, outbound 
 
Answer: D  

 
QUESTION 204: 
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SmartDashboard Smart Directory is to integrate which of the following with NGX? 
 
A. RADIUS server 
B. LDAP server 
C. UserAuthority server 
D. Account Management Client server 
 
Answer: B 
 
Explanation: It's integrated with LDAP server. VPN-1 NGX uses LDAP servers to 
obtain user information for authentication and authorization purposes. 

 
QUESTION 205: 
 
 
Exhibit: 

 
Your perimeter Security Gateway's external IP is 200.2000.200.3. Your network is 
displayed in the exhibit. 
Required: Allow only network 192.168.10.0 and 192.168.20.0 to get out to Internet, 
using 200.200.200.5. Assume you enable all the settings in the NAT page of Global 
Properties. 
How do you achieve this requirement while retaining granular control of NAT 
rules? 
 
A. Create two network objects: 192.168.10.0/24 and 192.168.20.0/24. Add the two 
network objects to a group object. Create a manual NAT rule like the following: Original 
Source - group object; Destination - any; Service - any; Translated source - 
200.200.200.5. Destination - original; Service - original. 
B. Create network objects for 192.168.10.0/24 and 192.168.20.0/24. Enable Hide NAT 
on both network objects, using 200.200.200.5 as hiding IP address. 
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C. Create a network object 192.168.0.0/16. Enable Hide NAT on the NAT page. Enter 
200.200.200.5 as hiding IP address. 
D. Create an Address Range object, starting from 192.168.10.1 to 192.168.20.254. 
Enable Hide NAT on the NAT page of the Address range object. Enter Hiding IP address 
200.200.200.5. 
 
Answer: D  

 
QUESTION 206: 
 
 
Which type of VPN-1 NGX Security Server does not provide User Authentication? 
 
A. NNTP Security Server 
B. HTTP Security Server 
C. HTTPS Security Server 
D. SMTP Security Server 
 
Answer: D 
 
Explanation: SMPT server don't allow authentication, it's allowed security content. 

 
QUESTION 207: 
 
 
Which specific VPN-1 NGX GUI would you use to add an address translation rule? 
 
A. SmartNAT 
B. SmartView Monitor 
C. SmartDashboard 
D. SmartConsole 
 
Answer: C 
 
Explanation: We use SmartDashboard to configure it. 

 
QUESTION 208: 
 
 
What do you configure to launch an application when certain traffic goes through 
certain rules? 
 
A. Pop-up alert script 
B. SNMP trap alert script 
C. Customer scripts cannot be executed through alert scripts. 
D. User-defined alert script. 
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Answer: D  

 
QUESTION 209: 
 
 
Exhibit: 

 
Please refer to the exhibit. 
You cannot use SmartDashboard's SmartDirectory features to connect to the LDAP 
server. What should you investigate? Select all that apply. 
 
A. 1 and 2 
B. 2 and 3 
C. 3 only 
D. 1, 2, and 3 
E. 1 only 
F. 1 and 3 
G. 2 only 
 
Answer: B 

 
QUESTION 210: 
 
 
Where can an administrator specify the notification action to be taken by the 
firewall in the event that available disk space drops below 15%? 
 
A. Real Time Monitor: Gateway Settings: Status Monitor 
B. This can only by monitored by a user-defined script 
C. SmartView Tracker: Audit Tab: Gateway Counters 
D. SmartView Monitor: Gateway Status: Threshold Settings 
 
Answer: D 

 
QUESTION 211: 
 
 
Which set of two objects both have an Authentication Tab? 
 
A. Users, User Groups 
B. Templates, Users 
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C. Networks, Hosts 
D. Users, Networks 
 
Answer: B  

 
QUESTION 212: 
 
 
You need to verify the effectiveness of your SmartDefense configuration for your 
Web server farm. You have a colleague run penetration tests to confirm that the 
Web servers are secure against traffic hijacks. 
What settings would be appropriate to configure before the test? 
 
A. Activate the Cross-Site Scripting property. 
B. Create resource objects for the web farm servers and configure rules for the web farm. 
C. Enable the Web intelligence > SQL injection setting. 
D. Configure TCP defenses such as "Small PMTU" size. 
 
Answer: A 

 
QUESTION 213: 
 
 
Which of the following choices contains the most complete list of valid, supported 
External Authentication schemes? 
 
A. SecurID, S-Key, Users 
B. Radius, AXENT, OS Password 
C. SecurID, S-Key, Users, AXENT 
D. SecurID, Radius, TACACS, OS Password 
 
Answer: D 

 
QUESTION 214: 
 
 
What does it indicate when a Check Point product name includes the word 
"SMART"? 
 
A. This product is a GUI client. 
B. Articificial Intelligence (AI) 
C. Security Management Architecture 
D. Stateful Managemente of All Routed Traffic 
 
Answer: C 
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QUESTION 215: 
 
 
Your current security scenario gives you the option to choose between a stand-alone 
installation or a distributed installation. Which of the following statements is TRUE 
for distributed installation? 
 
A. You are forced to use Windows as operating system. 
B. You have the option to install a secondary SmartCenter Server. 
C. Clientless VPN would not work in a distributed installation. 
D. You cannot install HFA's on the Security Gateway via SmartUpdate. 
 
Answer: B 

 
QUESTION 216: 
 
 
Exhibit: 

 
Given the following Rule Base, what must a public hospital Security Administrator 
do to comply with new health-care legislation requirements for logging all traffic 
accepted through the perimeter Security Gateway? 
The "Log Implied Rules" box in Global Properties is already selected. 
 
A. Use the "Implicit Rules" predefined query in SmartView Tracker. 
B. No additional charges are required. 
C. Check the "Log Implied Rules Globally" box on the VPN-1 NGX Gateway object. 
D. Select "Enable tracking all rules" in the Reporting Tools dialog box in Global 
Properties. 
 
Answer: B 

 
QUESTION 217: 
 
 
Anti-Spoofing is typically set up on which object types? 
 
A. Host 
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B. Domain 
C. Security Gateway 
D. Network 
 
Answer: C 
 
Explanation: Anti-spoofing is set to the security gateway interfaces. 

 
QUESTION 218: 
 
 
You want to display log entries containing information from a specific column in the 
SmartView Tracker. If you want to see ONLY those entries, what steps would you 
take? 
 
A. Right-click column > Search...> Add string > Apply Filter 
B. Left-click column > Specific > Add > Apply Filter 
C. Right-click column > Edit Filter > Specific > Add > OK 
D. Left-click column > Search > Add string > Apply Filter 
 
Answer: C 

 
QUESTION 219: 
 
 
Which Check Point address translation method is necessary if you want to connect 
from a host on the Internet via any service for a server with a reserved (RFC 1918) 
IP address on your DMZ? 
 
A. Port Address Translation 
B. Hide Address Translation 
C. Dynamic Source Address Translation 
D. Static Destination Address Translation 
 
Answer: D 

 
QUESTION 220: 
 
 
Exhibit: 
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You work as a network administrator for Certkiller .com. You study the exhibit 
carefully. 
Certkiller 's internal network uses address range 10.1.1.0/24. You need to allow this 
network to connect to the Internet. When network 10.1.1.0 tries to reach partner 
Web site 192.168.11.5 on the intranet across the DMZ, network 10.1.1.0 must use 
the DMZ interface IP address as the source address. 
How would you do this? 
Assume you have the following Network Topology established. 
One Security Gateway connected to the Internet via external router. The Security 
Gateway is protecting a DMZ with three Application Servers connected by a router 
and an internal user network connected by a hub. Topology Objects and IPs below: 
Security Gateway Ext Interface 210.210.210.10 
Security Gateway DMZ Interface 192.168.10.1 
DMZ Router to Gateway Interface 192.168.11.1 
DMZ Web Server interface 192.168.11.5 
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User net 10.1.1.0/24 
And you have created the following objects. 
Localnet = 10.1.1.0/24 
Node object "DMZ_door" = 192.168.10.1 
Node object "partner-web-site" = 192.168.11.5 
 
A. Add two Manual Hide NAT rules after the Automatic Hide NAT rules, as shown in 
the Exhibit section C. 
B. Enable Hide NAT on network object 10.1.1.0 and select "Hide behind Gateway". 
Then crate the NAT Rule Base shown in exhibit section A. 
C. Add two Manual Hide NAT rules after the Automatic Hide NAT rules, as shown in 
the Exhibit section B. 
D. Manually create one rule beneath the Automatic Manual Hide NAT rule, as shown in 
Exhibit D. The enable Automatic Hide NAT for localnet behind DMZ interface 
192.168.10.1, as shown in Exhibit section D. 
 
Answer: B 
 
Explanation: Exhibit A is correct as enabling the Hide NAT on the network object 
10.1.1.0 and selecting "Hide behind Gateway" ensures it can access the internet 
while hiding behind the external interface of the gateway. Furthermore, the manual 
hide NAT placed above it ensures that traffic specifically from "Localnet to the 
"partner-web-site" is hidden behind "DMZ_door" as required in the question. The 
important part is to ensure that the manual hide NAT for access to the partner site 
has been placed above the automatic NAT for access to the internet. 

 
QUESTION 221: 
 
 
Which Check Point address translation method allows an administrator to use 
fewer ISP-assigned IP addresses than the number of internal hosts requiring 
Internet connectivity? 
 
A. Static Source 
B. Hide 
C. Dynamic Destination 
D. Static Destination 
 
Answer: B 

 
QUESTION 222: 
 
 
A Stealth is used to: 
 
A. Prevent tracking of hosts behind the gateway 
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B. Prevent communication to the Security Gateway itself 
C. Make the Security Gateway appear as something else 
D. Hide the border from internal attacks 
 
Answer: B 

 
QUESTION 223: 
 
 
When you change an implicit rule's order from "last" to "first" in Global 
Properties, how do you make the change effective? 
 
A. Reinstall the Security Policy. 
B. Select save from the file menu. 
C. Select install database from the Policy menu. 
D. Run fw fetch from the Security Gateway. 
 
Answer: A 

 
QUESTION 224: 
 
 
What information is found in the Security Policy audit log? 
 
A. Destination IP address. 
B. Historical reports log 
C. ClusterXL sync failure 
D. Policy Package rule modification date/timp stamp 
 
Answer: D 

 
QUESTION 225: 
 
 
What command displays the version of an already installed firewall module? 
 
A. fw lic 
B. fw ver 
C. fw printver 
D. fw printlic 
 
Answer: B 

 
QUESTION 226: 
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How do you define a service object for a TCP port range? 
 
A. Manage Services, New Other, Provide name and define Protocol x-y 
B. Manage Services, New Other, Provide name and define Protocol 17, Range xx - yy 
C. Manage Services, New Group, Provide name and Add all service ports for range 
individually to the group object 
D. Manage Services, New TCP, Provide name and define Port: x-y 
 
Answer: D 
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